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ค าน า 

 

เอกสารเล่มนี้ เป็นคู่มือในการจัดท าบอร์ดความรู้   โดยได้ด าเนินการจัดท าแนวปฏิบัติ

ประกอบด้วย  ขั้นตอนการปฏิบัติงานรวมทั้งเทคนิควิธีการในการออกแบบจัดท าบอร์ดความรู้ด้วย

โปรแกรม Adobe Photoshop CS6  ผู้จัดท าพยายามเขียนให้เข้าใจได้ง่ายที่สุด ผู้ที่พ่ึงจะเริ่มเรียนรู้

โปรแกรม Adobe Photoshop CS6  สามารถปฏิบัติตามขั้นตอนที่เขียนไว้ได้โดยง่าย ซ่ึงจะเป็น

แนวทางส าหรับทุกคนในการจัดท าสื่อต่างๆ ให้เป็นไปในรูปแบบที่ต้องการ  กระบวนการเผยแพร่

ความรู้ประกอบด้วย  การศึกษาสภาพปัจจุบัน ปัญหา อุปสรรคและความต้องการ  การวางแผน 

ด าเนินการตามแผน  การสร้างสื่อเครื่องมือและพัฒนาวิธีการเผยแพร่ความรู้  ติดตามและประเมินผล

รายงานตามล าดับ  วัตถุประสงค์การเผยแพร่ข้อมูลข่าวสาร  เป็นเครื่องมือในการประชาสัมพันธ์การ

ให้มีความรู้และความเข้าใจที่ถูกต้องเกี่ยวกับเรื่องน่ารู้ต่างๆ  อันจะน ามาซึ่งการมีส่วนร่วมของภาค

ประชาชน  นอกจากนี้ยังเป็นเครื่องมือในการถ่ายทอดนโยบายไปสู่การปฏิบัติ  ตลอดจนเป็นช่องทาง

ในการสื่อสารระหว่างบุคลากรในองค์กร  โดยในการจัดท าคู่มือการปฏิบัติงาน  กระบวนการเผยแพร่

ข้อมูลข่าวสาร 
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  บทที่ 1 

บทน ำ 

 

1.1 ควำมเป็นมำและควำมส ำคัญของกำรจัดท ำคู่มือ 

 

ส ำนักกำรศึกษำต่อเนื่อง  เป็นหน่วยงำนที่มีหน้ำที่ให้บริกำรทำงวิชำกำรแก่สังคม  และท ำนุ

บ ำรุงศิลปวัฒนธรรมตำมพันธกิจของมหำวิทยำลัย  โดยมีกิจกรรมในรูปแบบต่ำงๆ ได้แก่  กำรส่งเสริม

กำรศึกษำตำมโครงกำรสัมฤทธิบัตรและโครงกำรสัมฤทธิบัตรบัณฑิตศึกษำ  กำรเผยแพร่ควำมรู้สู่

ประชำชนผ่ำนสื่อต่ำง ๆ กำรจัดอภิปรำยทำงวิชำกำร  กำรจัดสัมมนำ  กำรจัดนิทรรศกำร  กำรสำธิต/

กำรแสดง  กำรจัดกิจกรรมในชุมชนท้องถิ่น  กำรจัดฝึกอบรมหลักสูตรต่ำง ๆ  ทั้งวิชำกำรและวิชำชีพ

ให้แก่ประชำชน  หน่วยงำนภำครัฐและเอกชน กำรให้ค ำปรึกษำในกำรจัดฝึกอบรมแก่หน่วยงำนต่ำงๆ 

กำรจัดกำรศึกษำตำมอัธยำศัยที่เป็นสวิทยำกำรในอุทยำนกำรศึกษำให้ผู้สนใจสำมำรถศึกษำได้ด้วย

ตนเอง  เพ่ือเพ่ิมพูนควำมรู้  พัฒนำคุณภำพชีวิตและกำรงำนรวมถึงกำรจัดกิจกรรมนันทนำกำร  

ศิลปวัฒนธรรม  งำนประเพณีในเทศกำลต่ำงๆ เพ่ือเป็นกำรส่งเสริมท ำนุบ ำรุงศิลปวัฒนธรรม   

ฝ่ำยบริกำรเผยแพร่ทำงไกล  รับผิดชอบโครงกำรสัมฤทธิบัตร  ซึ่งเป็นโครงกำรที่กระจำย

โอกำสและควำมเสมอภำคทำงด้ำนกำรศึกษำให้ถ้วนทั่วทุกกลุ่มชน  จำกกำรเรียนรู้ด้วยตนเองผ่ำนสื่อ

สิ่งพิมพ์ซึ่งเป็นสื่อหลักของหลักสูตรทั้งระดับปริญญำตรี ปริญญำโทของ 12 สำขำวิชำ   ผู้เรียน

โครงกำรสัมฤทธิบัตร สำมำรถสมัครเรียนได้ทุกชุดวิชำ ไม่จ ำกัดวัยและวุฒิกำรศึกษำได้เพ่ิมพูนควำมรู้

และพัฒนำทักษะทำงวิชำกำร  และสำมำรถน ำควำมรู้ที่ได้รับไปพัฒนำและยกระดับคุณภำพชีวิต

เพ่ิมพูนวิทยฐำนะในหน้ำที่กำรงำนเพ่ิมประสิทธิภำพในกำรปฏิบัติงำน  ในหลักสูตรต่ำงๆ ตำมควำม

สนใจ  ยึดหลักกำรศึกษำตลอดชีวิตสมดังเป็นมหำวิทยำลัยของปวงชน  (อ้ำงในฝ่ำยบริกำรเผยแพร่

ทำงไกล, 2561)   

นอกจำกนี้ฝ่ำยบริกำรเผยแพร่ทำงไกลมีหน้ำที่ รับผิดชอบกำรให้บริกำรทำงวิชำกำรแก่สังคม

โดยกำรเผยแพร่ควำมรู้สู่ประชำชนผ่ำนสื่อ เช่น กำรจัดท ำบอร์ดควำมรู้ กำรฝึกอบรมด้ำนวิชำกำร กำร

จัดอภิปรำย กำรจัดโต้วำที กำรจัดนิทรรศกำร อย่ำงต่อเนื่องและสม่ ำเสมอ และกิจกรรมทำงวิชำกำร 

เป็นงำนบริกำรวิชำกำรแก่สังคมเพ่ือส่งเสริมกำรเรียนรู้ตลอดชีวิต ทั้งโครงกำรสัมฤทธิบัตรและกำร

http://www.stou.ac.th/โครงการสัมฤทธิบัตร/ฝ่ายบริการเผยแพร่ทางไกล/การเรียนโครงการสัมฤทธิบัตร
http://www.stou.ac.th/โครงการสัมฤทธิบัตร/ฝ่ายบริการเผยแพร่ทางไกล/การเรียนโครงการสัมฤทธิบัตร
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ใ ห้ บ ริ ก ำ ร วิ ช ำ ก ำ ร แ ก่ สั ง ค ม  เ น้ น ก ำ ร พั ฒ น ำ ท รั พ ย ำ ก ร ม นุ ษ ย์ ต ำ ม พั น ธ กิ จ ข อ ง

มหำวิทยำลัยสุโขทัยธรรมำธิรำช  ด้วยควำมก้ำวหน้ำทำงเทคโนโลยี  มีกำรใช้โปรแกรมคอมพิวเตอร์  

ท ำให้กำรผลิตสื่อเพ่ือกำรเผยแพร่ในงำนบริกำรวิชำกำร มีควำมสะดวกรวดเร็ว  สวยงำม ซึ่งกำรผลิต

บอร์ดควำมรู้เป็นงำนหนึ่งในฝ่ำยบริกำรเผยแพร่ทำงไกลที่สำมำรถจัดแสดง และเป็นส่วนประกอบที่

เป็นแหล่งควำมรู้ได้ทุกกิจกรรม ไม่ว่ำจะเป็นกำรจัดนิทรรศกำร กำรจัดโครงกำรฝึกอบรมต่ำงๆ กำรจัด

อภิปรำย หรือกิจกรรมอ่ืนใด เป็นแหล่งควำมรู้ส ำหรับผู้สนใจ  

ฝ่ำยบริกำรเผยแพร่ทำงไกล  มีกำรจัดท ำบอร์ดควำมรู้ในกิจกรรมที่เกี่ยวข้องของฝ่ำยเอง และ

จัดท ำบอร์ดควำมรู้ให้กับฝ่ำยต่ำงๆ ของส ำนักกำรศึกษำต่อเนื่อง  จึงอำจท ำให้กำรผลิตบอร์ดควำมรู้มี

ปริมำณไม่มำกนัก กำรเผยแพร่แนวทำงกำรจัดท ำบอร์ดควำมรู้ แก่บุคลำกรของส ำนักและผู้สนใจ

ทั่วไป จะท ำให้มีกำรผลิตบอร์ดควำมรู้ด้วยโปรแกรม Adobe Photoshop CS6 มีมำกขึ้น ก่อให้เกิด

ประโยชน์แก่ประชำชน 

 คู่มือกำรปฏิบัติงำน จะอธิบำยถึงกระบวนกำรท ำงำนของกำรจัดท ำบอร์ดควำมรู้ ด้วย

โปรแกรมดังกล่ำว ซึ่งจะอธิบำยขั้นตอนกำรจัดท ำ รำยละเอียดของกำรใช้โปรแกรม  Adobe 

Photoshop CS6 ในกำรออกแบบบอร์ดควำมรู้ทั้งภำพ กำรพิมพ์ข้อควำม ผลิตคล้ำยกัน ใช้หลักกำร

ออกแบบเหมือนกัน  และส่วนใหญ่จะใช้โปรแกรมกำรออกแบบคือโปรแกรม  Adobe Photoshop 

ซึ่งเป็นโปรแกรมที่มีควำมสำมำรถในกำรสร้ำงสีสัน  ควำมสวยงำม  มีควำมสำมำรถในกำรตกแต่ง

ภำพถ่ำย ภำพกรำฟิกได้อย่ำงมีประสิทธิภำพ  นอกจำกนี้ยังสำมำรถใส่ Effect ต่ำงๆ ให้กับภำพและ

ตัวหนังสือได้อย่ำงสวยงำม  กำรเปลี่ยนสีตัวอักษร เทคนิคกำรสร้ำงตัวอักษร กำรบันทึกข้อมูล จนถึง

ผลผลิตของงำน ซึ่งกระบวนกำรผลิตบอร์ดควำมรู้ด้วยโปรแกรม  Adobe Photoshop CS6 นี้จะเป็น

ประโยชน์ส ำหรับบุคลำกรในฝ่ำยบริกำรเผยแพร่ทำงไกล และบุคลำกรของส ำนักกำรศึกษำต่อเนื่องที่

เกี่ยวข้อง รวมทั้งผู้สนใจสำมำรถผลิตบอร์ดควำมรู้ ได้อย่ำงเป็นมำตรฐำนและเป็นมืออำชีพต่อไป  

 

1.2  วัตถุประสงค์ของกำรจัดท ำคู่มือ 

เพ่ืออธิบำยกระบวนกำร กำรจัดท ำบอร์ดควำมรู้ด้วยโปรแกรม Adobe Photoshop CS6  
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1.3  ขอบเขตของกำรจัดท ำคู่มือ 

         คู่มือเล่มนี้มีขอบเขตกำรด ำเนินกำรเฉพำะกระบวนกำร กำรจัดท ำบอร์ดควำมรู้ตั้งแต่ค้นคว้ำ

หำข้อมูลเสนอหัวหน้ำฝ่ำยพิจำรณำ ด ำเนินกำรออกแบบ พิสูจน์อักษร ตรวจสอบควำมถูกต้องของ

บทควำม ตรวจสอบงำนโดยหัวหน้ำฝ่ำย และผลงำนส ำเร็จ โดยกำรใช้โปรแกรม Adobe Photoshop 

CS6 

 

1.4 นิยำมศัพท์เชิงปฏิบัติกำร 

     1)  บอร์ดควำมรู้ หมำยถึง สื่อในกำรเผยแพร่ควำมรู้ขององค์กร เป็นเครื่องมือในกำร

ประชำสัมพันธ์ ชึ่งโดยทั่วไปสำมำรถเลือกวัสดุในกำรจัดท ำบอร์ดได้หลำกหลำยรูปแบบ ทั้งแผ่นไม้ 

พลำสติก ฟิวเจอร์บอร์ด พำรำโบล่ำ เหล็ก กระดำษ กระดำนด ำ บอร์ดส ำเร็จรูป หรือวัสดุอ่ืนๆ แต่ใน

คู่มือเล่มนี้ ก ำหนดขอบเขตเฉพำะ กำรจัดท ำบอร์ดควำมรู้ด้วยแผ่นป้ำยไวนิล ซึ่งสำมำรถก ำหนดขนำด

ได้หลำกหลำยขนำดตำมลักษณะ/ควำมเหมำะสมของพ้ืนที่จัดแสดง เป็นบอร์ดส ำเร็จรูปที่มีเนื้อหำ

พิมพ์ติดอยู่กับแผ่นป้ำยไวนิลโดยตรงเป็นวัสดุที่ทนทำนต่อน้ ำและแสงแดด  สำมำรถเคลื่อนย้ำยได้

สะดวกและน ำไปจัดแสดงได้ทันท ี

    2)  โปรแกรม Adobe Photoshop CS6 หมำยถึง ชุดค ำสั่งที่ใช้สำหรับตกแต่งรูปภำพ สร้ำง

งำนกรำฟิกต่ำงๆ หลักกำรท ำงำนคือ กำรสร้ำงภำพโดยเริ่มต้นจำกหน้ำกระดำษเปล่ำๆ  กำรหยิบ

ภำพถ่ำยข้ึนมำปรับแต่งให้ดูดี สมบูรณ์ หรือแหวกแนว ในรูปแบบที่ต้องกำร ขั้นตอนทั้งหมดจะท ำงำน

อยู่บนหน้ำจอของเครื่องคอมพิวเตอร์ และแบ่งออกได้หลำยด้ำนเป็นโปรแกรมสร้ำงสรรค์ภำพ และ

ตกแต่งภำพกรำฟิกที่ได้รับควำมนิยมเป็นอย่ำงมำก มีเครื่องมือที่พร้อมต่อกำรใช้งำน ควำมสำมำรถ

พ้ืนฐำนของ Adobe Photoshop มีดังนี้ ตกแต่งหรือแก้ไขรูปภำพ ตัดต่อภำพบำงส่วน หรือที่เรียกว่ำ 

crop ภำพ เปลี่ยนแปลงสีของภำพ จำกสีหนึ่งไปอีกสีหนึ่งได้ สำมำรถลำกเส้นแบบฟรีสไตล์ หรือใส่

รูปภำพ สี่เหลี่ยม วงกลม หรือสร้ำงภำพได้อย่ำงมีอิสระ มีกำรแบ่งชั้นของภำพเป็น Layer สำมำรถ

เคลื่อนย้ำยภำพได้เป็นอิสระต่อกัน กำรท ำ cloning ภำพ หรือกำรท ำภำพซ้ ำในรูปภำพเดียวกัน 

เพ่ิมเติมข้อควำม ใส่ effect ของข้อควำมได้ หลักกำรท ำงำนในคู่มือเล่มนี้ใช้  โปรแกรม Adobe 

Photoshop CS6  
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1.5  ประโยชน์ที่จะได้รับจำกคู่มือ 

1) ผู้ปฏิบัติกำรสำมำรถทรำบกระบวนกำรผลิตบอร์ดควำมรู้ด้วยโปรแกรม  Adobe  

Photoshop CS6  อย่ำงเป็นระบบ 

2) บุคลำกรในฝ่ำยบริกำรเผยแพร่ทำงไกล  สำมำรถผลิตบอร์ดควำมรู้ด้วยโปรแกรม   

Adobe Photoshop CS6  ได้ในแนวทำงเดียวกันและสำมำรถท ำงำนแทนกันได้ 

3) ผู้ปฏิบัติงำนสำมำรถท ำบอร์ดควำมรู้ด้วยโปรแกรม  Adobe Photoshop CS6  

ไดอ้ย่ำงมืออำชีพ และมีประสิทธิภำพมำกยิ่งขึ้น 
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บทที่ 2 
การวิเคราะห์งาน 

 
1. ประวัติมหาวิทยาลัยสุโขทัยธรรมาธิราช     

มหาวิทยาลัยสุโขทัยธรรมาธิราช เป็นมหาวิทยาลัยในระบบเปิดก่อตั้งขึ้นจากแนวคิดเรื่องการ

ขยายโอกาสทางการศึกษาในระดับอุดมศึกษาให้เข้าถึงประชาชนมากที่สุด โดยด าเนินการสอนโดยใช้

ระบบการสอนทางไกล เป็นการจัดการเรียนการสอนโดยเน้นให้นักศึกษาเรียนรู้ด้วยตนเองจาก

เอกสารชุดวิชาจากสื่อสารสนเทศต่างๆ ที่ทางมหาวิทยาลัยจัดไว้ให้นักศึกษา เช่น สื่อสิ่งพิมพ์ สื่อ

อิเล็กทรอนิกส์และสื่อต่างๆ เป็นต้น ซ่ึงพระบาทสมเด็จพระเจ้าอยู่หัวภูมิพลอดุลยเดช ทรงพระกรุณา

โปรดเกล้าฯ พระราชทานชื่อ มหาวิทยาลัยสุโขทัยธรรมาธิราช ตามพระนามเดิมขอพระบาทสมเด็จ

พระเจ้าอยู่หัว รัชกาลที่ 7 เมื่อครั้งทรงด ารงพระอิสริยยศเป็น กรมหลวงสุโขทัยธรรมาราชา และเมื่อ 

วันที่ 5 กันยายน พ.ศ. 2521 พระบาทสมเด็จพระเจ้าอยู่หัวภูมิพลอดุลยเดช ได้ทรงลงพระปรมาภิไธย

ในพระราชบัญญัติมหาวิทยาลัยสุโขทัยธรรมาธิราช ดังนั้นจึงก าหนดให้วันที่ 5 กันยายนของทุกปี เป็น

วันสถาปนามหาวิทยาลัย โดยได้พระราชโองการโปรดเกล้าฯ แต่งตั้งกรรมการสภามหาวิทยาลัยชุด

แรก และแต่งตั้งศาสตราจารย์ ดร.วิจิตร ศรีสอ้าน ให้ด ารงต าแหน่งอธิการบดีคนแรกเมื่อวันที่ 24 

ตุลาคม 2521 ทั้งนี้มหาวิทยาลัยได้รับพระบรมราชานุญาตให้ใช้พระราชลัญจกรในพระบาทสมเด็จ

พระปกเกล้าเจ้าอยู่หัว ซึ่งเป็นรูปพระแสงศรสามองค์เรียงกัน ภายใต้พระมหามงกุฏ น ามาประกอบกับ

ส่วนยอดของเจดีย์ ทรงพุ่มข้าวบิณฑ์ ซึ่งเป็นสัญลักษณ์ของกรุงสุโขทัย เป็นตราประจ ามหาวิทยาลัย สี

เขียวทองเป็นสีประจ ามหาวิทยาลัย สีเขียวเป็นสีประจ าวันพุธ ซึ่งเป็นวันพระราชสมภพของ

พระบาทสมเด็จพระปกเกล้าเจ้าอยู่หัว ส่วนสีทองเป็นสีแห่งสิริมงคล ต้นปาริชาตหรือต้นทองหลางลาย

เป็ นต้ น ไม้ป ระจ ามหาวิ ยาลั ย  ซึ่ งมี ใบ สี เขี ย วและลายริ้ วสี ทองตามแนวเส้ น ใบ  (อ้ างใน

มหาวิทยาลัยสุโขทัยธรรมาธิราช, 2561)  
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ภาพที่ 1 ตราประจ ามหาวิทยาลัย        

มหาวิทยาลัยสุโขทัยธรรมาธิราช มีภารกิจหลักในการด าเนินงาน 4 ประการ คือ การจัดการ

เรียนการสอน การวิจัย การบริการวิชาการแก่สังคม และการท านุบ ารุงศิลปวัฒนธรรม โดย

มหาวิทยาลัยมีสาขาวิชาจ านวน 12 สาขาวิชาในการรับผิดชอบด้านวิชาการ และมีส านักและสถาบัน

ต่างๆ จ านวน 12 หน่วยงาน ด าเนินการสนับสนุนภารกิจต่างๆ ของมหาวิทยาลัย  

  การบริหารมหาวิทยาลัยได้แบ่งส่วนราชการออกเป็นสาขาวิชาต่างๆ 12 สาขาวิชา มีฐานะ

เทียบเท่าคณะ รับผิดชอบงานด้านวิชาการประกอบด้วย 

1) สาขาวิชาศิลปศาสตร์ 

2) สาขาวิชาศึกษาศาสตร์         

3) สาขาวิชาวิทยาการจัดการ 

4) สาขาวิชานิติศาสตร์ 

5) สาขาวิชาเศรษฐศาสตร์ 

6) สาขาวิชาวิทยาศาสตร์สุขภาพ 

7) สาขาวิชามนุษยนิเวศศาสตร์   

8) สาขาวิชารัฐศาสตร์ 

9) สาขาวิชาส่งเสริมการเกษตรและสหกรณ์ 

         10) สาขาวิชานิเทศศาสตร์ 

         11) สาขาวิชาวิทยาศาสตร์และเทคโนโลยี 

         12) สาขาวิชาพยาบาลศาสตร์ 

มหาวิทยาลัยได้แบ่งส่วนราชการที่รับผิดชอบงานสนับสนุนด้านวิชาการประกอบด้วยส านัก 

สถาบัน ศูนย์ 12 หน่วยงานและศูนย์วิทยพัฒนา มหาลัยสุโขทัยธรรมาธิราช 10 จังหวัด ประกอบด้วย 



7 
 

1) ส านักงานอธิการบดี   

2) ส านักวิชาการ            

3) ส านักทะเบียนและวัดผล     

4) ส านักเทคโนโลยีการศึกษา 

5) ส านักบริการการศึกษา      

6) ส านักบรรณสารสนเทศ     

7) ส านักพิมพ์        

8) ส านักการศึกษาต่อเนื่อง        

9) ส านักคอมพิวเตอร์       

         10) สถาบันวิจัยและพัฒนา 

         11) ส านักบัณฑิตศึกษา 

         12) ศูนย์วิทยพัฒนา มหาลัยสุโขทัยธรรมาธิราช 10 จังหวัด ด าเนินการสนับสนุนภารกิจ

มหาวิทยาลัย 

  

 

 

 

 

 

 

 

 

 
                                                         ศูนย์วิทยพัฒนา มหาวิทยาลยัสุโขทัยธรรมาธริาช 

ภาพที่ 2 โครงสร้างของมหาวิทยาลัยสุโขทัยธรรมาธิราช 

(ที่มา : https://www.stou.ac.th สืบค้นเมื่อวันที่ 1 พฤษภาคม 2562) 
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2. การวิเคราะห์งาน 

 2.1 โครงสร้างของส านักการศึกษาต่อเนื่อง 

 ส านักการศึกษาต่อเนื่องจัดตั้งขึ้นตามพระราชกฤษฎีกาการจัดตั้งส านักการศึกษาต่อเนื่อง  

มหาวิทยาลัยสุโขทัยธรรมาธิราช พ.ศ. 2531 เมื่อวันที่ 28 ธันวาคม 2531   ซึ่งประกาศในราชกิจจา

นุ เบกษา  ฉบับพิ เศษ หน้า 10  เล่ม 105  ตอนที่  239  วันที่  30 ธันวาคม 2531  โดยที่

มหาวิทยาลัยสุโขทัยธรรมาธิราช ได้มีการขยายงานด้านการบริการวิชาการแก่สังคม เช่น การให้

การศึกษาอบรมหลักสูตรต่าง ๆ ในระยะสั้นแก่ประชาชน และหน่วยงานต่างๆ ทั้งของภาครัฐและของ

เอกชน การผลิตสื่อโสตทัศน์ รวมทั้งการท านุบ ารุงศิลปวัฒนธรรม โดยเฉพาะอย่างยิ่งการจัดตั้ง

อุทยานการศึกษา เพ่ือให้เป็นแหล่งการศึกษาตามอัธยาศัยของประชาชนทุกเพศทุกวัย และเป็น

ศูนย์กลางของชุมชนในการจัดกิจกรรมทางวิชาการ นันทนาการ ศิลปวัฒนธรรม และงานประเพณีใน

เทศกาลต่างๆ  เพ่ือเป็นการส่งเสริมท านุบ ารุงศิลปวัฒนธรรม 

ภารกิจส านักการศึกษาต่อเนื่อง           

1. การให้บริการทางวิชาการแก่สังคม ได้แก่ 

1.1 การจัดฝึกอบรมหลักสูตรระยะสั้นแก่ผู้สนใจทั่วไป 

1.2 การให้บริการจัดฝึกอบรมตามความต้องการของหน่วยงานต่าง ๆ  

     ทั้งภาครัฐและเอกชน 

       1.3 การจัดโครงการสัมฤทธิบัตร 

     1.4 การเผยแพร่ความรู้ผ่านสื่อ รวมทั้งกิจกรรมรูปแบบต่าง ๆ 

     1.5 การจัดกิจกรรมเผยแพร่ความรู้สู่ชุมชนท้องถิ่น 

   2. การส่งเสริมท านุบ ารุงศิลปวัฒนธรรม  ได้แก่ 

    2.1 การจัดงานประเพณีส าคัญต่าง ๆ ของไทย 

2.2 การเผยแพร่ความรู้ด้านศิลปวัฒนธรรมผ่านสื่อ รวมทั้งกิจกรรม 

     รูปแบบต่าง ๆ 

2.3 การจัดแสดงด้านศิลปวัฒนธรรม 

2.4 การจัดกิจกรรมท านุบ ารุงศาสนา 
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วิสัยทัศน์ พันธกิจ ค่านิยมองค์กร 

          วิสัยทัศน์   

“องค์กรชั้นน าด้านการฝึกอบรม การเรียนรู้ตลอดชีวิต และศิลปวัฒนธรรมอย่าง

ยั่งยืน” 

          พันธกิจ   

1. พัฒนาทรัพยากรมนุษย์ด้วยการฝึกอบรม 

2. พัฒนาทุนมนุษย์สู่การเรียนรู้ตลอดชีวิต 

3. สืบสานศิลปวัฒนธรรมไทยสู่สากล 

          ค่านิยมองค์กร    

1. คุณภาพ (Quality) 

2. ประทับใจ (Impression) 

3. มืออาชีพ (Professional) 

 

โครงสร้างการบริหารงานภายในของส านักการศึกษาต่อเนื่อง  

  ส านักการศึกษาต่อเนื่อง แบ่งการบริหารงานออกเป็น 6 ฝ่าย ฝ่ายให้บริการที่สามารถพึงพา

ตนเองได้ 3 ฝ่าย คือ ฝ่ายบริหารการฝึกอบรม ฝ่ายพัฒนาสื่อและเทคโนโลยีการฝึกอบรม และฝ่าย

วิเคราะห์โครงการและหลักสูตรการฝึกอบรม ฝ่ายที่ให้บริการวิชาการแก่สังคม 2 ฝ่าย คือ ฝ่ายบริการ

เผยแพร่ทางไกล และฝ่ายอุทยานการศึกษา และฝ่ายที่อ านวยการสนับสนุนการบริหารและจัดการ

ส านักงาน คือ ส านักงานเลขานุการ มีการด าเนินการตามนโยบายภายใต้การก ากับดูแลของรอง

อธิการบดีฝ่ายบริการวิชาการและพันธกิจสัมพันธ์กับชุมชน และรองอธิการบดีฝ่ายวางแผน ท านุบ ารุง

ศิลปวัฒนธรรมและอุทยานการศึกษา  
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ภาพที่ 3  ผังงานโครงสร้างการบริหาร ส านักการศึกษาต่อเนื่อง 
ทีม่า : รายงานการประเมินตนเอง ประจ าปีการศึกษา 2560 (30 กันยายน 2561) 

สืบค้นเมื่อวันที่ 6 กุมภาพันธ์ 2562 
    

1. ส านักงานเลขานุการ  

  ส านักงานเลขานุการเป็นหน่วยงานกลางในการให้การสนับสนุนการด าเนินงานใน

ฝ่ายต่าง ๆ ของส านัก โดยมีพันธกิจ 4 งาน ประกอบด้วย งานอ านวยการ งานบุคคลและระบบงาน  

งานแผนงาน และการการเงิน บัญชีและงบประมาณ  

 

2. ฝ่ายบริหารการฝึกอบรม  

   รับผิดชอบการประชาสัมพันธ์หลักสูตรการฝึกอบรมและจัดฝึกอบรมแก่ประชาชน

ผู้สนใจทั่วไปและหน่วยงานต่างๆ  เพ่ือเพ่ิมพูนทักษะ ประสบการณ์การท างานด้านต่างๆ ให้ค าปรึกษา

ด้านการบริหารการฝึกอบรมแก่หน่วยงานต่าง ๆ และให้ค าปรึกษาด้านการจัดฝึกอบรมให้กับ

หน่วยงานทั้งภาครัฐและเอกชน โดยมีพันธกิจ 4 งาน ประกอบด้วย งานธุรการ งานประชาสัมพันธ์ 

งานจัดท าข้อมูลกลุ่มเป้าหมาย งานฝึกอบรมหลักสูตรทั่วไป และงานฝึกอบรมหลักสูตรความร่วมมือ 
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3. ฝ่ายพัฒนาสื่อและเทคโนโลยีการฝึกอบรม  

  รับผิดชอบในการจัดหา ออกแบบ  พัฒนา  และผลิตสื่อ  รวมทั้งงานศิลปกรรมที่ใช้

ในการฝึกอบรม  การจัดระบบเทคโนโลยีการฝึกอบรม และให้ค าปรึกษาในการผลิตสื่อการฝึกอบรม

แก่หน่วยงานต่างๆ โดยมีพันธกิจ 5 งาน ประกอบด้วย งานธุรการ งานสื่ออิเล็กทรอนิกส์ งานฝึกอบรม

ทางไกล งานสื่อศิลปกรรม และงานสื่อสิ่งพิมพ์ 

 

4. ฝ่ายวิเคราะห์โครงการและหลักสูตรการฝึกอบรม  

   รับผิดชอบในการพัฒนาและจัดท าหลักสูตรฝึกอบรม  การประเมินผลและติดตาม

ผลการฝึกอบรม เสนอข้อก าหนดการรับจัดฝึกอบรมกับหน่วยงานต่าง ๆ และให้ค าปรึกษาด้านการ

จดัท าโครงการ  การวิเคราะห์ความต้องการการฝึกอบรม การจัดท าหลักสูตร และการประเมินผลการ

ฝึกอบรมแก่หน่วยงานต่าง ๆ โดยมีพันธกิจ 5 งาน ประกอบด้วย งานธุรการ งานวิเคราะห์โครงการ 

งานจัดท าโครงการและพัฒนาหลักสูตร งานการตลาด และงานประเมินผล 

5. ฝ่ายอุทยานการศึกษา  

รับผิดชอบในการจัดกิจกรรมทางวิชาการและนันทนาการ โดยมุ่งเน้นการส่งเสริม 

ฟ้ืนฟู ท านุบ ารุงและเผยแพร่ศิลปวัฒนธรรมไทย เพ่ือเป็นปัจจัยเสริมคุณภาพทางการศึกษาและ

คุณภาพชีวิต โดยมีพันธกิจ 4 งาน ประกอบด้วย งานธุรการ งานท านุบ ารุงศิลปวัฒนธรรม และงาน

อุทยานการศึกษา และงานสื่อนวัตกรรม 

   

6. ฝ่ายบริการเผยแพร่ทางไกล  

รับผิดชอบการให้บริการทางวิชาการแก่สังคมโดยการเผยแพร่ความรู้สู่ประชาชนผ่าน

สื่อต่าง ๆ  เช่น วิทยุกระจายเสียง อินเทอร์เน็ต เป็นต้น และการจัดโครงการสัมฤทธิบัตร  โครงการ

สัมฤทธิบัตรบัณฑิตศึกษา ที่เป็นการส่งเสริมการศึกษาตลอดชีวิตและการเรียนรู้ตามอัธยาศัยโดยไม่มุ่ง

ปริญญาบัตร  และการเผยแพร่ความรู้สู่ชุมชนท้องถิ่น เพ่ือสร้างความเข้มแข็งให้แก่ชุมชน โดยมีพันธกิจ 

4 งาน ประกอบด้วย งานธุรการ งานโครงการสัมฤทธิบัตร งานกิจกรรมวิชาการเพ่ือสังคม งานสื่อ

นวัตกรรมวิชาการเพื่อสังคม 
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ฝ่ายบริการเผยแพร่
ทางไกล  

1.นางเปรมปรีดิ์ ไทยเท่ียง 
     รักษาการในต าแหน่ง   
  หวัหน้าฝา่ยบริการเผยแพร ่             
  ทางไกล            

งานสื่อและนวัตกรรม
วิชาการเพื่อสังคม  

( 2 คน) นายชัยณรงค์ นพศิริ 
นางสาวภาวิณี ปุริมปรัชญ ์

งานโครงการสัมฤทธิบัตร  
( 2  คน) 

นางเปรมปรีดิ์ ไทยเท่ียง 
นางสาวกชพร จูฑะจันทร ์

งานกิจกรรมวิชาการ 

เพื่อสังคม  (1  คน) 
นางสาวอุษณีษ ์โฉมฉายแสง 

งานธุรการ  (1 คน)  
นางสาววรรณวิลัย พูลอนันท ์

2.2 โครงสร้างของฝ่ายบริการเผยแพร่ทางไกล 

 

ภาพที่ 4  ผังงานโครงสร้างการบริหาร ฝ่ายบริการเผยแพร่ทางไกล 

ที่มา : รายงานการประเมินตนเอง ประจ าปีการศึกษา 2560 (30 กันยายน 2561) 
สืบค้นเมื่อวันที่ 6 กุมภาพันธ์ 2562 

 

1. งานสื่อและนวัตกรรมวิชาการเพื่อสังคม 

งานสื่อและนวัตกรรมวิชาการเพ่ือสังคม  แบ่งเป็น 4 งานดังนี้          

1.1 งานจัดท าบอร์ดเพื่อเผยแพร่ความรู้ (ผู้รับผิดชอบ ภาวิณี ปุริมปรัชญ์) 

1) ศึกษาค้นคว้าหาข้อมูลเพื่อน ามาเผยแพร่ในบอร์ดความรู้  

2) ออกแบบและด าเนินการจัดท าบอร์ดความรู้ 

3) จัดซื้อจัดจ้างและประสานงานกับหน่วยงานภายนอกในการจัดท าบอร์ดความรู้ 

4) พิสูจน์อักษรและตรวจแก้ไขบอร์ดความรู้ ค าผิด ค าถูก   

5) ติดตั้งบอร์ดความรู้ หน้าส านักการศึกษาต่อเนื่อง และอาคารเฉลิมพระเกียรติ 

6) ประเมินผลกิจกรรมบอร์ดความรู้ โดยวิเคราะห์จากใบสอบถามที่ได้รับ 

            7) ออกแบบของที่ระลึกงานบอร์ดความรู้ ส าหรับผู้ตอบแบบประเมิน 

8) จัดส่งของที่ระลึกให้ผู้ตอบแบบประเมินบอร์ดทางไปรษณีย์  
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  9) พิมพ์หนังสือขอความอนุเคราะห์ขอเผยแพร่บอร์ดความรู้ต่อไปยังศูนย์วิทย

พัฒนามหาวิทยาลัยสุโขทัยธรรมาธิราช 10 ศูนย ์  

                     10) จัดส่งบอร์ดความรู้ไปยังศูนย์วิทยพัฒนา 10 ศูนย์ ของมหาวิทยาลัยสุโขทัย- 

ธรรมาธิราช 

         11) งานอ่ืนๆ ที่ได้รับมอบหมาย    

1.2 งานผลิตสื่อสิ่งพิมพ์เพื่อการประชาสัมพันธ์   

1)  โครงการสัมฤทธิบัตร    

1.1 ป้ายไวนิลประชาสัมพันธ์โครงการสัมฤทธิบัตร ปีละ 4 รุ่น ติดป้ายด้านหน้า

มหาวิทยาลัย และตดิป้ายหน้าศูนย์วิทยพัฒนา 10 ศูนย์ ของมหาวิทยาลัยสุโขทัยธรรมาธิราช 

1.2 ด าเนินการศึกษาค้นคว้าหาข้อมูลของโครงการสัมฤทธิบัตรในแต่ละรุ่น 

ค้นคว้าหาหัวข้อประชาสัมพันธ์ให้ทันยุคทันสมัยในแต่ละรุ่น 

1.3 พิสูจน์อักษรและตรวจแก้ไข Art work ค าผิดค าถูกในแต่ละรุ่น  

1.4 ประสานงานในการจัดซื้อจัดจ้าง ท าป้ายไวนิลในการประชาสัมพันธ์ 

1.5 จัดท าป้ายไวนิลประชาสัมพันธ์ออกบูธแนะน าโครงการสัมฤทธิบัตร โดย

ออกแบบเป็นลักษณะป้ายไวนิลส าหรับติดวัสดุแบบ X-stand 

1.6 งานอ่ืนๆ ตามที่ได้รับมอบหมาย   

2) งานสื่อและศิลปกรรมพิธีมอบประกาศนียบัตรและสัมฤทธิบัตร 

2.1 จัดนิทรรศการ/ตกแต่งเวที/ตกแต่งซุ้มยินดีต้อนรับ/ป้ายต่างๆ ในบริเวณงาน

พิธีมอบประกาศนียบัตรและสัมฤทธิบัตร  

2.2  จัดท าข้อมูลและออกแบบประชาสัมพันธ์พิธีมอบสัมฤทธิบัตร 

2.3  ประสานงานในการจัดซื้อจัดจ้างกับหน่วยงานภายนอก ในการจัดงานพิธี

มอบประกาศนียบัตรและสัมฤทธิบัตร 

2.4  ท าตัวอักษรประดับเวทีงานพิธีมอบสัมฤทธิบัตร 

2.5  คัดเลือกภาพท าบอร์ดและโปสเตอร์ในงานพิธีมอบสัมฤทธิบัตร  

2.6  ด าเนินการจัดซื้อวัสดุอุปกรณ์งานศิลปกรรม ส าหรับใช้ในการจัดงานพิธี

มอบประกาศนียบัตรและสัมฤทธิบัตร 
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2.7  จัดท าบอร์ดข้อมูลต่างๆ ป้ายบอกทางต่างๆ และบอร์ดประมวลภาพพิธี

มอบประกาศนียบัตรและสัมฤทธิบัตร 

2.8 ออกแบบของที่ระลึกเพ่ือการประชาสัมพันธ์โครงการสัมฤทธิบัตร  เช่น 

กระเป๋าส าหรับแจกผู้เรียนในโครงการสัมฤทธิบัตร 

2.9 ตกแต่งสถานที่ภายในห้องประชุมและบริเวณหน้าห้องประชุมงานพิธีมอบ

สัมฤทธิบัตร   

2.10  จัดท าและออกแบบซุ้มแสดงความยินดี พร้อมติดตั้งและตกแต่งซุ้มให้

สวยงาม  

                         2.11  จัดเก็บอุปกรณ์ตกแต่งเวทีบอร์ด และป้ายต่างๆ เมื่อเสร็จสิ้นงานพิธีมอบ

ประกาศนียบัตรและสัมฤทธิบัตร 

2.12  งานอ่ืนๆ ตามท่ีได้รับมอบหมาย    

3)  สื่อสิ่งพิมพ์เพื่อสังคม งานอภิปรายและงานเสวนาทางวิชาการ  

3.1  ออกแบบป้ายไวนิลประชาสัมพันธ์งานอภิปรายและงานเสวนาทางวิชาการ

ฝ่ายบริการเผยแพร่ทางไกล ติดตั้งหน้ามหาวิทยาลัยสุโขทัยธรรมาธิราช และหน้าอาคารวิทยทัศน์ 

3.2  ออกแบบจัดท าบอร์ดความรู้ และจัดนิทรรศการงานอภิปรายและงาน

เสวนาทางวิชาการค้นคว้าหาข้อมูลเนื้อหาให้ตรงกับวัตถุประสงค์ของเนื้องาน 

3.3  ออกแบบและจัดท าโปสเตอร์งานอภิปรายและงานเสวนาทางวิชาการ 

3.4  พิสูจน์อักษรและตรวจแก้ไข Art work ค าผิดค าถูก 

3.5  ด าเนินการจัดซื้อวัสดุอุปกรณ์งานศิลปกรรม ส าหรับใช้ในงานอภิปรายและ

งานเสวนาทางวิชาการ 

3.6  ประสานงานในการจัดซื้อจัดจ้าง ส าหรับใช้ในงานอภิปรายและงานเสวนา

ทางวิชาการ 

3.7  ติดโปสเตอร์ประชาสัมพันธ์งานอภิปรายและงานเสวนาทางวิชาการทุก

หน่วยงานในมหาวิทยาลัย 

3.8  ตกแต่งสถานที่ และติดป้ายพร้อมตกแต่งเวที ในงานอภิปรายและงาน

เสวนาทางวิชาการ 
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3.9  ออกแบบของที่ระลึกเพ่ือการประชาสัมพันธ์ เช่น กระเป๋าส าหรับแจก

ผู้เข้าร่วมงานอภิปรายและงานเสวนาทางวิชาการ 

3.10  เป็นเจ้าหน้าที่ในงานอภิปรายและงานเสวนาทางวิชาการ 

3.11  จัดเก็บอุปกรณ์ตกแต่งเวที บอร์ดและป้ายต่างๆ งานอภิปรายและงาน

เสวนาทางวิชาการ เมื่อเสร็จสิ้นกิจกรรม 

                         3.12  งานอ่ืนๆ ตามที่ได้รับมอบหมาย      

     1.3 เผยแพร่บทความผ่านสื่ออินเทอร์เน็ต (ผู้รับผิดชอบ นายชัยณรงค์ นพศิริ) 

     1) ประชุมคณะบรรณาธิการพิจารณาบทความเชิงปกิณกะ เพ่ือเผยแพร่ทาง

อินเทอร์เน็ต 

     2) ประชาสัมพันธ์เชิญชวนผู้สนใจเข้าร่วมกิจกรรมผ่านเว็บไซต์ 

     3) รวบรวมตรวจสอบบทความตามเกณฑ์เพ่ือส่งคณะบรรณาธิการพิจารณา 

     4) แจ้งผลผู้ผ่านการพิจารณา 

     5) ออกแบบเว็บเพจบทความท่ีผ่านการพิจารณาและเผยแพร่ 

     6) ประกาศผลผู้ร่วมกิจกรรมตอบค าถามจากบทความ 

     7) จัดส่งค่าเขียนบทความผ่านการพิจารณา จ่ายค่าตอบแทนคณะบรรณาธิการและ

ของที่ระลึกผู้ตอบค าถาม  

     8) ประเมินผลผู้ร่วมกิจกรรม 

     9) งานอ่ืนๆ  ตามที่ได้รับมอบหมาย    

            1.4 จัดระบบสารสนเทศ และประชาสัมพันธ์กิจกรรมฝ่ายบริการเผยแพร่ทางไกลผ่าน

สื่อต่างๆ  

           1) ประชาสัมพันธ์โครงการสัมฤทธิบัตร โครงการสัมฤทธิบัตรบัณฑิตศึกษา ผังรายการ

วิทยุกระจายเสียง (รายเดือน/ปี)   และประมวลภาพกิจกรรมงานฝ่ายบริการเผยแพร่ทางไกลผ่านทาง

อินเทอร์เน็ต 

            2) ถ่ายภาพกิจกรรมต่าง ๆ 

              3) จัดระบบสื่อวัสดุอุปกรณ์โสตทัศน์และให้บริการยืม รับคืน 

            4) งานอ่ืนๆ  ตามท่ีได้รับมอบหมาย     
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2. งานโครงการสัมฤทธิบัตร (ผู้รับผิดชอบ นางเปรมปรีดิ์ ไทยเที่ยง นางสาวกชพร จูฑะจันทร์) 

งานโครงการสัมฤทธิบัตร แบ่งเป็น 2 งาน ดังนี้ 

    2.1 โครงการสัมฤทธิบัตร  (สัมฤทธิบัตรปริญญาตรี) 

    1) ประสานสาขาวิชาก าหนดชุดวิชาและรายวิชา  เพ่ือเสนอสภาวิชาการอนุมัติเปิด

สอนชุดวิชาและรายวิชา 

    2) จัดท าเอกสารการสมัครเรียน  ใบสมัคร และระเบียนประวัติผู้เรียนโครงการ

สัมฤทธิบัตร 

           3) จัดท าเอกสารการประชาสัมพันธ์ 

    4) ลงพื้นที่รณรงค์ประชาสัมพันธ์เชิงรุก 

   5) ประสานงานหน่วยงานภายในมหาวิทยาลัย 

    6) ให้ค าแนะน าและตอบปัญหา  ด้วยตนเอง ทางจดหมาย  ทางโทรศัพท์ และสื่อ

ออนไลน์ 

    7) จัดท าสถิติผู้เรียนโครงการสัมฤทธิบัตร 

    8) จัดงานพิธีมอบประกาศนียบัตรและสัมฤทธิบัตร 

        9) จัดท าผลวิเคราะห์ข้อมูลผู้เรียนโครงการสัมฤทธิบัตร 

       10) งานอ่ืนๆ ตามที่ได้รับมอบหมาย  

   2.2 โครงการสัมฤทธิบัตรบัณฑิตศึกษา  (สัมฤทธิบัตรปริญญาโท) 

   1) ประสานงาน 12 สาขาวิชา เพื่อก าหนดชุดวิชาที่เปิดสอน 

   2) จัดท าข้อมูลและเอกสารประกอบน าเสนอคณะกรรมการบัณฑิตศึกษาเพ่ือ 

พิจารณาขออนุมัติการเปิดสอนในโครงการสัมฤทธิบัตรบัณฑิตศึกษา 

   3) จัดท าเอกสารการสมัครเรียน ใบสมัคร ระเบียนประวัติผู้เรียนโครงการสัมฤทธิ

บัตรบัณฑิตศึกษา 

   4) จัดท าข้อมูล และชุดวิชาที่เปิดสอนโครงการสัมฤทธิบัตรบัณฑิตศึกษา เพ่ือ

เผยแพร่ทางอินเทอร์เน็ต 

   5) จัดท าแผนการประชาสัมพันธ์ และจัดส่งเอกสารการสมัครเรียนโครงการสัมฤทธิ

บัตรบัณฑิตศึกษาไปยังกลุ่มเป้าหมายภายใน  ภายนอก  และหน่วยงานเครือข่าย 
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    6) จัดท าข้อมูลโครงการสัมฤทธิบัตรบัณฑิตศึกษา  เพ่ือประชาสัมพันธ์ผ่านสื่อ

สิ่งพิมพ์  สื่ออินเทอร์เน็ต สื่ออิเลคทรอนิกส์  (วิทยุกระจายเสียง  วิทยุโทรทัศน์) 

   7) จัดท าสถิติผู้สมัครเรียนโครงการสัมฤทธิบัตรบัณฑิตศึกษา 

   8) งานอ่ืนๆ ตามท่ีได้รับมอบหมาย 

3. งานกิจกรรมวิชาการเพื่อสังคม  (ผู้รับผิดชอบ นางสาวอุษณีษ์ โฉมฉายแสง) 

   งานกิจกรรมวิชาการเพ่ือสังคม  แบ่งเป็น 3 ดังนี้ 

  3.1 รายการวิทยุกระจายเสียง 

    1) จัดท าแผนการด าเนินงานและกรอบรายการประจ าปี 

    2) สืบค้นและค้นคว้าข้อมูลในการผลิตรายการ 

    3) ประสานงานในการผลิตรายการ 

    4) ด าเนินการผลิตรายการวิทยุกระจายเสียง 

  5) สรุปผลการผลิตรายการและจัดท าเอกสารรายการวิทยุกระจายเสียงประจ าปี 

  6) จัดท าแผนการจัดส่งเอกสารและจัดส่งเอกสารรายการวิทยุกระจายเสียงให้แก ่

กลุ่มเป้าหมาย 

  7) ให้บริการส าเนาวิทยุกระจายเสียง ตามเอกสารรายการวิทยุกระจายเสียง  

ประจ าปีแก่ผู้สนใจ 

  8) ประเมินผลการผลิตรายการวิทยุกระจายเสียง ผ่านทางสื่ออินเทอร์เน็ต 

  9) ส่งของที่ระลึกให้แก่ผู้ร่วมกิจกรรมตอบค าถามในรายการถูกต้อง 

         10) งานอื่นๆ ที่ได้รับมอบหมาย 

  3.2 งานอภิปรายทางวิชาการ 

  1) ก าหนดประเด็นเพื่อจัดท าโครงการและงบประมาณ 

  2) สืบค้นและค้นคว้าพร้อมจัดท าเอกสารประกอบการอภิปราย 

  3) ประสานงานด าเนินการจัดอภิปราย 

  4) จัดท าแผนและประชาสัมพันธ์หากลุ่มเป้าหมาย 

  5) ด าเนินการจัดอภิปราย 

  6) สรุปผลการด าเนินงานอภิปราย 

  7) งานอ่ืนๆ ที่ได้รับมอบหมาย 
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 3.3 งานเผยแพร่ความรู้สู่ชุมชน 

  1) ก าหนดแผนกลุ่มเป้าหมาย 

  2) ส ารวจความต้องการของพ้ืนที่กลุ่มเป้าหมาย 

  3) ค้นคว้าหาข้อมูลและจัดท าเอกสารประกอบ 

  4) ก าหนดแผนปฏิบัติงานและด าเนินการลงพื้นท่ีให้บริการ 

  5) สรุปผลการด าเนินงาน 

  6) งานอ่ืนๆ ที่ได้รับมอบหมาย    

4. งานธุรการและสารบรรณ  (ผู้รับผิดชอบ นางสาววรรณวิลยั  พูลอนันท์) 

งานธุรการและสารบรรณ  มีความรับผิดชอบดังนี้   

      1) รับ ส่ง เวียนหนังสือ 

      2) ร่าง โต้ตอบหนังสือ   

      3) การจัดซื้อจัดจ้าง 

     4) การยืมเงินและคืนเงิน 

      5) จัดท าสถิติการลา 

      6) งานพิมพ์ของฝ่าย   

      7) ประสานงานทั่วไป 

     8) จัดเก็บเอกสาร 

     9) งานประชุมฝ่าย 

         10) งานอ่ืนๆ ตามที่ได้รับมอบหมาย 

แนวคิด ทฤษฎีที่เกี่ยวข้องในการจัดท าบอร์ดความรุ ้

คู่มือการปฏิบัติงาน การจัดท าบอร์ดความรู้  ด้วยโปรแกรม Adobe Photoshop CS6 ผลิต

ขึ้นโดยมีแนวคิด ทฤษฎีที่เกี่ยวข้อง เป็นกรอบในการผลิต ดังนี้ 

1. แนวคิดเก่ียวกับความรู้ 

2. แนวคิดเก่ียวกับสื่อใหม่ 

3. ทฤษฎีแพร่กระจายนวัตกรรม 
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1. แนวคิดเกี่ยวกับความรู้ 

1) ความหมายของความรู้ 

ความรู้เป็นสิ่งจ าเป็นส าหรับมนุษย์ทุกคนในโลกใบนี้และความรู้ได้อยู่คู่กับโลกมาช้านาน 

ทั้งความรู้ที่รูปธรรม และความรู้ที่เป็นนามธรรม มนุษย์เป็นผู้แสวงหาความรู้และค้นพบความรู้ แท้จริง

แล้วความรู้จึงเกิดจากการเรียนรู้ การฝึกฝน ทดลอง ประสบการณ์ และมีการแลกเปี่ยนความรู้ซึ่งกัน

และกันจนเกิดเป็นองค์ความรู้ใหม่ๆ ขึ้นมาเพ่ือใช้ในการพัฒนาตนเองและองค์กร 

ความรู้จึงเป็นทรัพยากรทางเศรษฐกิจที่มีอิทธิพลอย่างส าคัญและเป็นปัจจัยชี้ขาดของ

ความได้เปรียบในการแข่งขันในศตวรรษที่ 20 เป็นยุคที่มีการเปลี่ยนแปลงอย่างรุนแรงมากที่สุดที่เคย

มีมา เพราะสังคมเป็นสังคมแห่งการเรียนรู้  (Knowledge-based society)  และเกิดพนักงานที่ใช้ภูมิ

ปัญญา (Knowledge worker) มีจ านวนเพ่ิมขึ้นอย่างรวดเร็วในประเทศที่พัฒนาแล้วทุกประเทศ 

ความรู้ที่จะน ามาประยุกต์ใช้ในการท างาน (Knowledge in application) หรือที่เรียกว่า “สังคมแห่ง

การเรียนรู้” เป็นสังคมที่ประกอบด้วยแก่นสารสาระส าคัญท่ีการจัดการ 

การเริ่มต้นสังคมแห่งความรู้นั้น ในปัจจุบันหลายองค์กร ใช้กลยุทธ์การพัฒนาทรัพยากร

บุคคลให้มีความรู้ เกิดทักษะต่างๆ เพ่ือใช้ประโยชน์ในการปฏิบัติงานอย่างมีประสิทธิภาพและ

ประสิทธิผลสูงสุดและพัฒนาต่อเนื่องตลอดชีวิต ทรัพยากรบุคคลในฐานะที่เป็นทรัพย์สินอันมีค่ายิ่ง

ขององค์กรและ “ความรู้” ซึ่งมีอยู่ในตัวบุคคล ความรู้ขององค์กรในการท างานสร้างสรรค์นวัตกรรม 

(innovation) เพ่ือสร้างความได้เปรียบทางการแข่งขัน การสร้างนวัตกรรมในองค์กร จ าเป็นต้องมีการ

พัฒนากระบวนการจัดการความรู้ ทุกคนสามารถน าความรู้ไปเพ่ือพัฒนากระบวนการจัดการความรู้

และสามารถน าความรู้ไปเพ่ือพัฒนาสิ่งใหม่ๆ ให้เกิดประสิทธิภาพในการผลิตและการบริการ ทุก

องค์กรจึงต้องเรียนรู้ที่จะท างานอย่างชาญฉลาดบนพื้นฐานของทุนปัญญาและความรู้ (น้ าทิพย์ วิภาวิน

,2546,น.16,อ้างในพระมหาชวลิต คงแก้ว,2560) 

ความรู้หมายถึง ผลที่ได้จากการเรียนรู้ การศึกษาค้นคว้า ประสบการณ์  และความ

ช านาญของบุคคลแต่ละคนที่สั่งสมมาทางตา หู จมูก ลิ้น กายและใจ (อายตนะภายนอกท้ัง 6) แล้วน า

ความรู้เหล่านั้นมาแลกเปลี่ยนซึ่งกันและกันจนเกิดเป็นองค์ความรู้ใหม่เพ่ือน าไปใช้ในการพัฒนา

ทรัพยากรบุคคลและพัฒนาองค์กรให้เป็นองค์กรแห่งความรู้ และเกิดการสร้างสรรค์นวัตกรรม 

สรุป การจัดท าบอร์ดความรู้ เป็นความรู้ที่ชัดแจ้ง เป็นความรู้ที่ผู้รับสารไม่ต้องอาศัย

ประสบการณ์ โดยส านักการศึกษาต่อเนื่อง ได้บอกเล่าผ่านการเห็นของผู้รับสาร 
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2) ประเภทของความรู้ 

ราชบัณฑิตยสถาน พจนานุกรมศัพท์ปรัชญาอังกฤษ-ไทย (2540, น.54) ได้แบ่งความรู้

ออกเป็นประเภทต่างๆ ดังนี้ 

ความรู้ก่อนประสบการณ์ (Priori knowledge) คือความรู้ที่ไม่ต้องอาศัยประสบการณ์ 

(1)  ความรู้หลังประสบการณ์ (Posteriori knowledge) คือเป็นความรู้ที่เกิดข้ึนหลังมี 

ประสบการณ์แล้ว 

(2) ความรู้โดยประจักษ์ (Knowledge by acquaintance) คือความรู้ที่เกิดจากสิ่งที่ถูก

รู้ซึ่งปรากฏโดยตรงต่อผู้รู้ผ่านทางหู ตา จมูก ลิ้น กาย หรือใจ 

(3) ความรู้โดยบอกเล่า (Knowledge by description)คือความรู้ที่เกิดจากการบอกเล่า 

(4) ความรู้เชิงประจักษ์ หรือความรู้เชิงประสบการณ์ (Empirical knowledge) คือ 

ความรู้ที่ได้รับจากประสบการณ์ หรือความรู้หลังประสบการณ์ 

(5) ความรู้โดยตรง (Immediate  knowledge) คือความรู้ที่ได้รับโดยอาศัยสัมผัสทั้ง 6 

ได้แก่ การเห็น การได้ยิน ได้กลิ่น ได้รส ได้สัมผัส และรับรู้ทางใจ 

(6) ความรู้เชิงปรวิสัย หรือความรู้เชิงวัตถุวิสัย (Objective knowledge) คือความรู้ที ่

เกิดจากเหตุผล หรือประสบการณ์ท่ีสามารถอธิบาย หรือทดสอบให้ผู้อ่ืน ได้รับรู้อย่างที่ตนได้รับ 

      ส านักงานคณะกรรมการการพัฒนาระบบราชการ (ก.พ.ร.) และสถาบันเพ่ิมพูนผลผลิต

แห่งชาติ (2548,น.4,อ้างในพระมหาชวลิต คงแก้ว,2560) ได้แบ่งความรู้ออกเป็น 2 ประเภท คือ 

(1) ความรู้ที่อยู่ในตัวบุคคล (Tacit knowledge) เป็นความรู้ที่ได้จากประสบการณ์  

พรสวรรค์ หรือสัญชาตญาณของต่ละบุคคลในการท าความเข้าใจในสิ่งต่างๆ เป็นความรู้ที่ไม่สามารถ

ถ่ายทอดออกมาเป็นค าพูดหรือลายลักษณ์อักษรได้โดยง่าย เช่น ทักษะในการท างาน ฝีมือ หรือการคิด

เชิงสร้างสรรค์ บางครั้งจึงเรียกว่าความรู้แบบนามธรรม 

(2) ความรู้ที่ชัดแจ้ง (Explicit knowledge) เป็นความรู้ที่สามารถรวบรวม ถ่ายทอดได้ 

โดยผ่านวิธีการต่างๆ เช่น  การบันทึกเป็นลายลักษณ์อักษร ทฤษฎี คู่มือต่างๆ และบางครั้งเรียกว่า

เป็นความรู้แบบรูปธรรม 

สรุปความรู้คือ สิ่งที่มนุษย์สร้าง ผลิต ความคิด ความเชื่อ ความจริง ความหมาย โดยใช้ 

ข้อเท็จจริง ข้อคิดเห็น ตรรกะ แสดงผ่านภาษา เครื่องหมาย และสื่อต่าง ๆ โดยมีเป้าหมายและ

วัตถุประสงค์เป็นไปตามผู้สร้าง ผู้ผลิตจะให้ความหมาย 
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2. แนวคิดเกี่ยวกับสื่อใหม่ 

 เสาวนี ชินนาลอง (2560,หน่วยที่7เล่มที่2) อธิบายว่า แนวคิดเกี่ยวกับสื่อใหม่เริ่มต้นราว

ทศวรรษที่ 1990 เมื่อมาร์กโพสเตอร์ (Mark Poster) พิมพ์หนังสือชื่อ The Second Media Age 

หรือยุคที่ 2 ของสื่อซึ่งเสนอแนวคิดว่าสื่อก้าวเข้าสู่ยุคใหม่ซึ่งมีเทคโนโลยีเข้ามาช่วยในการปฏิสัมพันธ์ 

และเป็นการสื่อสารในลักษณะเครือข่ายโดยเฉพาะอย่างยิ่งเครือข่ายอินเทอร์เน็ตซึ่งจะพลิกโฉมหน้า

การสื่อสารไปเลย ในขณะที่ยุคแรกของสื่อ สื่อมีลักษณะคือ 1) การผลิตโดยกลุ่มใดกลุ่มหนึ่งนั่นคือ

ผลิตจากคนจ านวนน้อยเพ่ือเผยแพร่ไปยังคนจ านวนมาก (one to many) 2) เป็นลักษณะของการ

สื่อสารแบบทางเดียวเป็นส่วนใหญ่ 3) ส่วนใหญ่โดนควบคุมโดยรัฐ 4) ผู้รับสารมีลักษณะเป็นมวลชน

ซึ่งแบ่งเป็นกลุ่มก้อน ในขณะที่ยุคที่ 2 ของสื่อนั้นจะมีลักษณะคือ 1) การผลิตจะไม่เป็นการรวมศูนย์ 

นั่นคือ การผลิตเนื้อหาในสิ่งต่างๆ ที่เผยแพร่ไปไม่ได้รวมศูนย์อยู่ที่องค์กรสื่ออีกต่อไปแล้ว แต่สมาชิก

ในสังคมอ่ืนๆสามารถเป็นผู้ผลิตสารได้เช่นกัน ดังเราจะเห็นได้จากการเผยแพร่ข่าวสารผ่านทางเฟชบุ๊ก 

โดยสมาชิกเฟซบุ๊กซึ่งไม่ได้เป็นนักข่าวมืออาชีพหรือสังกัดส านักข่าวอาชีพ 2) เป็นการสื่อสารแบบสอง

ทาง อินเทอร์เน็ตท าให้สื่อในยุคที่ 2 กลายเป็นสื่อสารแบบสองทาง นั่นคือ ผู้รับสารสามารถตอบกลับ 

(feedback) มายังผู้ส่งสารหรือผู้ผลิตได้อย่างง่ายดายและทันทีทันใด 3) สื่ออยู่นอกเหนือการควบคุม

ของรัฐ การผลิตสื่อเพ่ือเผยแพร่ทางอินเทอร์เน็ต ไม่ว่าจะผ่านทางสื่อสังคม (social media) หรือ

ช่องทางอ่ืนๆ เช่น เว็บไซต์ ยูทู๊ป (Youtube) ท าให้รัฐควบคุมสื่อเหล่านี้ได้น้อยมาก การควบคุมท าได้

เพียงใช้ความรุนแรงด้วยการปิดเว็บไซต์ 4) มีลักษณะเป็นประชาธิปไตย เมื่อสื่อถูกควบคุมได้น้อย

ดังกล่าวข้างต้น สื่อจึงมีความเป็นอิสระสูง 5) เป็นสื่อที่เน้นตอบสนองปัจเจกบุคคลมากกว่ามวลชน 

เนื่องจากช่องทางการสื่อสารและผู้ส่งสารที่ไม่ใช่องค์กรอีกต่อไป ท าให้ค่าใช้จ่ายในการผลิตมีราคา

ต่ าลงมาก ส่งผลให้สื่อในยุคที่สองสามารถเจาะกลุ่มผู้รับสารที่เป็นกลุ่มเล็กๆ และมีลักษณะเฉพาะ

ได้มากขึ้น (niche) 

สื่อใหม่ (New Media) มีบทบาทส าคัญต่อองค์การในการสื่อสาร การมอบหมายงาน การ

รายงานผลการปฏิบัติงาน และช่วยเสริมสร้างความสัมพันธ์อันดีระหว่างบุคลากรในองค์ก ารและ

ภายนอกองค์การ ด้วยการเผยแพร่ข้อมูลและกิจกรรมขององค์การผ่านสื่อใหม่หลากหลายรูปแบบ 

ดังนั้นองค์การทุกภาคส่วน จ าต้องมีกลยุทธ์และนโยบายการใช้สื่อใหม่ที่ชัดเจนและเป็นรูปธรรม

ผู้บริหารองค์การควรพิจารณาถึงลักษณะของธุรกิจว่าสื่อใหม่ประเภทใดที่เหมาะสมกับการน ามาใช้ใน

การสื่อสารทั้งภายในและภายนอกองค์การ รวมทั้งจะน าสื่อใหม่เหล่านั้นมาใช้เป็นสื่อหลักหรือจะ
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น ามาใช้ในลักษณะผสมผสานกับสื่อที่มีอยู่เดิมในองค์การ อันมีบทบาทส าคัญในการสร้างภาพลักษณ์

ขององค์การ (Organization Branding) น ามาใช้ในงานเพ่ือช่วยให้องค์การยกระดับขีดความสามารถ

ทางการแข่งขัน (Competitive Advantage) เพ่ือให้องค์การอยู่รอดได้ (Organizational Survival)

ในสภาพแวดล้อมที่มีการเปลี่ยนแปลงได้อย่างมั่นคงและยั่งยืน 

        สรุปบอร์ดงานนวัตกรรมสื่อฝ่ายบริการเผยแพร่ทางไกล ส านักการศึกษาต่อเนื่อง จึงจ าเป็นต้อง

น าคุณสมบัติของสื่อใหม่มาใช้ผลิตสื่อบอร์ดความรู้สู่สังคม เพ่ือให้สอดคล้องกับพันธกิจขององค์กร 

และเป็นการสร้างภาพลักษณ์ขององค์กรในการท านวัตกรรมมาใช้ในการปฏิบัติงาน 

 

3. ทฤษฎีการแพร่กระจายนวัตกรรม (Diffusion of Innovation Theory) 

Rogers (1985,อ้างใน สุรีย์รักษ์ วงษ์ทิพย์,2562,น.88) เป็นผู้พัฒนาทฤษฎีการแพร่กระจาย

นวัตกรรม โดยให้นิยามของค าว่าการแพร่กระจาย (Diffusion) ว่าหมายถึงกระบวนการซึ่งนวัตกรรม

ได้รับการติดต่อผ่านช่องทางการสื่อสารที่แน่นอนเป็นระยะเวลาหนึ่งในกลุ่มสมาชิกของสังคม ส่วนค า

ว่านวัตกรรม (Innovation) หมายถึงความคิด การปฏิบัติ หรือวัตถุที่ผู้น าไปใช้คิดว่าเป็นสิ่งใหม่ และ

จากการที่ Rogers ได้อธิบายความถึง “สื่อใหม่” ว่าเป็นสื่อที่ช่วยให้เกิดการแลกเปลี่ยนข้อมูลข่าวสาร

ระหว่างผู้สื่อสารจ านวนมากผ่านระบบสื่อสารที่มีคอมพิวเตอร์เป็นศูนย์กลาง อาทิ สื่อสังคม จะเห็นได้

ว่าสื่อใหม่เป็นทั้งวัตถุและเป็นทั้งการปฏิบัติรูปแบบใหม่ ที่มีผู้คนน าไปใช้ตามความหมายของ

นวัตกรรมจนเกิดการเปลี่ยนแปลงรูปแบบของสังคม การพิจารณาการเปลี่ยนแปลงขององค์การ เพ่ือ

สอดรับการเปลี่ยนแปลงของสังคมและเทคโนโลยี อันเกิดจากอิทธิพลของ “สื่อสังคม” ที่ท าให้รูปแบบ

ของสังคมเปลี่ยนไป ผ่านทางทฤษฎีการแพร่กระจายนวัตกรรมนั้น จะเห็นได้ว่าการที่หลักของทฤษฎี

การแพร่กระจายนวัตกรรมตั้งอยู่บนพ้ืนฐานของฐานคติที่ว่า เมื่อบุคคลหรือองค์การได้รับข้อมูล

ข่าวสารเกี่ยวกับประสิทธิภาพของนวัตกรรมใดๆ ผ่านทางช่องทางการสื่อสารแล้วนั้น บุคคลหรือ

องค์การจะรับเอานวัตกรรมไปใช้ ดังนั้น “ที่มาของการเปลี่ยนแปลง” ที่เกิดขึ้น จึงอยู่ที่การประเมิน

ผลตอบแทนที่ได้รับจากนวัตกรรมเป็นส าคัญ ซึ่งการวิเคราะห์ถึงอิทธิพลแวดล้อมของสื่อสังคมที่มีผล

ให้องค์การต่างๆ ต้องปรับตัวเข้ากับการเปลี่ยนแปลงตามที่กล่าวมา สามารถพิจารณาใน 2 ประเด็น 

ได้แก่ 1) กระบวนการตัดสินใจรับนวัตกรรม และ 2) อัตราการรับนวัตกรรม  (Rogers, 1985) 

กล่าวคือ 1) กระบวนการตัดสินใจรับนวัตกรรม : “สื่อสังคม” ที่มีอิทธิพลต่อการเปลี่ยนแปลงรูปแบบ

ทางสังคม ก็ส่งผลต่อกระบวนการตัดสินใจรับนวัตกรรม อันน ามาสู่การเปลี่ยนแปลงภายในองค์การ 
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ตามขั้นตอนดังนี้ เมื่อบุคลากรภายในองค์การเกิดการรับรู้ว่ามีนวัตกรรมของสื่อรูปแบบใหม่เกิดขึ้น 

และเกิดการเรียนรู้จนเป็นความเข้าใจในการท างาน อรรถประโยชน์ของสื่อสังคมแล้ว ก็จะเกิดเป็น

ความรู้ (Knowledge) และส่งผลให้เกิดการชักชวน (Persuasion) ให้บุคคลอ่ืนๆ ภายในองค์การ

เล็งเห็นถึงความส าคัญของการใช้ ตลอดจนประโยชน์ของสื่อสังคม อันจะท าให้เกิดเป็นการตัดสินใจ 

(Decision) ที่จะยอมรับการน าเอาสื่อสังคมเข้ามาปรับใช้ในการปฏิบัติงานในรูปแบบที่ต่างๆ ภายใน

องค์การ ซึ่งการตัดสินใจยอมรับก็น ามาสู่การน าไปปฏิบัติให้เกิดผล (Implementation) คือ การที่

องค์การริเริ่มน าเอาสื่อสังคม เข้ามาปรับใช้ให้เป็นผลในการสื่อสารในองค์การ จนท้ายสุดเกิดเป็นการ

ยืนยันผล (Confirmation) หรือกล่าวอีกนัยว่าเป็นการยืนยันความถูกต้องของการตัดสินใจรับเอา

นวัตกรรมสื่อสังคมเข้ามาปรับใช้ในองค์การ 

สรุปการจัดท าบอร์ดความรู้ของส านักการศึกษาต่อเนื่อง เพื่อเผยแพร่ต่อประชาชน ทั้งภายใน

มหาวิทยาลัยและศูนย์วิทยพัฒนา 10 แห่งทั่วประเทศ ผู้ผลิตบอร์ดความรู้เกิดการยอมรับนวัตกรรม

ของสื่อใหม่ เกิดการเรียนรู้โดยบอร์ดความรู้นี้ได้ใช้ชุดค าสั่ง โปรแกรม Adobe Photoshop CS6 เพ่ือ

ผลิตให้รูปแบบเนื้อหามีความทันสมัย น่าสนใจให้ความรู้แก่ประชาชนทั่วไป นักศึกษา และบุคลากรใน

มหาวิทยาลัย เพ่ือน าความรู้มาใช้ประโยชน์ในชีวิตประจ าวัน เน้นการพัฒนาตนเองด้านการท างาน 

คุณภาพชีวิต และอาจเป็นแนวทางในการวางจุดมุ่งหมายในอนาคต รวมทั้งแนวทางในการด าเนิน

ชีวิตประจ าวันให้ถูกต้อง ทันสมัยต่อไป 

  

 

 

 

 

 

 



 บทที่ 3 
องค์ประกอบของระบบงานจัดท าบอร์ดความรู ้

 

3.1 ความหมายของบอรด์ความรู ้  

บอร์ดความรู้  หมายถึง สื่อในการเผยแพร่ความรู้ขององค์กร เป็นเครื่องมือในการ

ประชาสัมพันธ์ มีลักษณะเป็นแผ่นป้ายไวนิล เป็นสื่อทัศนวัสดุประเภทหนึ่งที่มีลักษณะเฉพาะ คือเป็น

แผ่นป้ายที่ท าหน้าที่เสนอเนื้อหาเพ่ือถ่ายทอดความรู้ให้ผู้ชมได้เรียนรู้ตามความเหมาะสม รูปแบบเป็น

ป้ายส าเร็จรูปที่มีเนื้อหาพิมพ์ติดอยู่กับแผ่นป้ายโดยตรงสามารถน าไปจัดแสดงได้ทันที  

การจัดท าบอร์ดความรู้ โดยใช้สื่อใหม่  โปรแกรมการออกแบบคือโปรแกรม  Adobe 

Photoshop ซึ่งเป็นโปรแกรมที่มีความสามารถในการสร้างสีสรร  ความสวยงาม  มีความสามารถใน

การตกแต่งภาพถ่าย ภาพกราฟิกได้อย่างมีประสิทธิภาพ  ทั้งยังสามารถใส่ Effect ต่างๆ ให้กับภาพ

และตัวหนังสือได้อย่างสวยงาม นอกจากนี้ยังเป็นเครื่องมือในการถ่ายทอดนโยบายไปสู่การปฏิบัติ  

ตลอดจนเป็นช่องทางในการสื่อสารระหว่างบุคลากรในองค์กร  โดยในการจัดท าคู่มือการปฏิบัติงาน  

กระบวนการเผยแพร่ข้อมูลความรู้  ในปัจจุบันนี้คอมพิวเตอร์ได้เข้ามามีอิทธิพลอย่างมากในการท าสื่อ

ออกแบบเพ่ือใช้ในการถ่ายทอดความรู้  การออกแบบด้วยคอมพิวเตอร์ได้รับความนิยมอย่าง

กว้างขวางเพราะเป็นสื่อท่ีสามารถดึงดูดความสนใจได้เป็นอย่างดี   

ปัจจุบันการออกแบบสื่อนี้มีความหมายขยายขอบเขตกว้างขวางไปถึงกิจกรรมที่สามารถสื่อ

ความรู้สึกนึกคิด ความรู้ อารมณ์ และเรื่องราวข่าวสารไปสู่กลุ่มเป้าหมายได้ เอกสารเล่มนี้จะเป็นการ

รวบรวมเนื้อหาสาระส าคัญที่มีความจ าเป็นต่อการผลิตสื่อในการท าบอร์ดความรู้  รวมทั้งขั้นตอนการ

ปฏิบัติงาน  เพ่ือให้รู้ขั้นตอนการท างาน  อีกทั้งเทคนิควิธีการออกแบบเพ่ือให้สามารถน าไปประยุกต์ใช้

ให้เหมาะสมกับงานต่างๆ  นอกจากนี้ยังสอดแทรกเทคนิควิธีพิเศษต่างๆ ที่ได้จากประสบการณ์การ

ท างานรวมทั้งจากการศึกษาเรียนรู้พัฒนา  มารวบรวมไว้ในเอกสารนี้อีกด้วย  โดยจะเน้นรูปแบบการ

ผลิตสื่อที่เป็นบอร์ดความรู้เป็นหลัก  เพ่ือเป็นแนวทางในการจัดท าบอร์ดความรู้ให้เป็นไปในรูปแบบ

แนวทางเดียวกัน  และเพ่ือให้บุคลากรที่เกี่ยวข้องมีความรู้ความเข้าใจและทราบถึงขั้นตอนในการ

ปฏิบัติงาน  และสามารถจัดท าบอร์ดความรู้ได้อย่างมีประสิทธิภาพ   
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ฝ่ายบริการเผยแพร่ทางไกล  มีหน้าที่รับผิดชอบการให้บริการทางวิชาการแก่สังคมโดยการ

เผยแพร่ความรู้สู่ประชาชนผ่านสื่อและกิจกรรมทางวิชาการ เป็นงานบริการวิชาการแก่สังคมเพ่ือ

ส่งเสริมการเรียนรู้ตลอดชีวิต เป็นยุทธศาสตร์ด้านการพัฒนาและเสริมสร้างศักยภาพบุคคล กระจาย

โอกาสและความเสมอภาคทางด้านการศึกษาให้ถ้วนทั่วทุกกลุ่มชน  จากการเรียนรู้ด้วยตนเองผ่านสื่อ

การสอนต่างๆ  โดยไม่มีอุปสรรคด้านเวลาและสถานที่เป็นการเปิดโอกาสให้ทุกคน  ไม่จ ากัดวัยและ

วุฒิการศึกษาได้เพ่ิมพูนความรู้และพัฒนาทักษะทางวิชาการ  และสามารถน าความรู้ที่ได้รับไปพัฒนา

และยกระดับคุณภาพชีวิตเพ่ิมพูนวิทยฐานะในหน้าที่การงานเพ่ิมประสิทธิภาพในการปฏิบัติงาน  ใน

หลักสูตรต่างๆ ตามความสนใจ  ยึดหลักการศึกษาตลอดชีวิตสมดังเป็นมหาวิทยาลัยของปวงชน 

นอกจากนี้ การจัดระบบงานจัดท าบอร์ดความรู้ของส านักการศึกษาต่อเนื่องนั้นถือว่าเป็นส่วนส าคัญ

ส่วนหนึ่งของการเผยแพร่ความรู้  จากภาระงานที่ได้รับมอบหมายหลายประการตามข้างต้นนั้น  

ผู้จัดท าจึงได้น าเรื่องการจัดท าบอร์ดความรู้ด้วยโปรแกรม Adobe Photoshop CS6  มาจัดท าเป็น

คู่มือการปฏิบัติงานขึ้นมา โดยมีขั้นตอนการปฏิบัติงาน (Flow Chart) ในเรื่องของการท าบอร์ดความรู้  

เพ่ือให้ผู้ปฏิบัติงานสามารถด าเนินการได้รวดเร็ว มีมาตรฐานและมีความเป็นมืออาชีพ   

 

3.2 กระบวนการจัดท าบอร์ดความรู้   

กระบวนการจัดท าบอร์ดความรู้  เป็นการอธิบายถึงขั้นตอนการท างานอย่างละเอียดว่าได้ท า

อะไร ที่ไหน อย่างไร เมื่อไร ช่วยให้เห็นภาพความสัมพันธ์ระหว่างบุคคลและงาน เพ่ือวางขั้นตอนการ

ท างาน โดยเขียนออกมาในรูปของ Flow chart ท าให้เกิดความเข้าใจง่าย กระบวนการจัดท าบอร์ด

ความรู้ มี 6 ขั้นตอนดังนี้ 

1. ค้นคว้าหาข้อมูล 

2. เสนอหัวหน้าฝ่ายพิจารณา 

3. ด าเนินการออกแบบ 

4. พิสูจน์อักษร  และตรวจสอบความถูกต้องของบทความ 

5. ตรวจสอบงานโดยหัวหน้าฝ่าย 

6. ผลงานส าเร็จ  

7. การเผยแพร่ 
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                                     1. ค้นคว้าหาข้อมูล 

 

                                                                                
                           ไม่ผ่าน 

                        2. เสนอหัวหน้าฝ่ายพิจารณา 

 
                                            ผ่าน 

 
                            3. ด าเนินการออกแบบ 

 
 

 
                           4. พิสูจน์อักษรและตรวจสอบ 
                               ความถูกต้องของบทความ 

 
                             

                                5. ตรวจสอบงานโดย               ไม่ผ่าน 
                                  หัวหน้าฝ่าย 
                                                 ผ่าน 
                                                 

6. ผลงานส าเร็จ 
                        การเผยแพร่ 

 

 

7. เผยแพร่ความรู้  

 

ภาพที่ 5 แสดงข้ันตอนการปฏิบัติงาน (Flow Chart) การจัดท าบอร์ดความรู้ 
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สัญลักษณ์การปฏิบัติงาน (Flow Chart) 

สัญลักษณ์ ความหมาย 

 จุดเริ่มต้น และสิ้นสุด (terminal) 

จุดเริ่มต้น และสิ้นสุดของกระบวนการ 

 

 

การตัดสินใจ (decision) 

การตัดสินใจ การตรวจสอบ การอนุมัติ 

 

 

การปฏิบัติงาน (process) 

คือ กิจกรรมและการปฏิบัติงาน 

 

 

ทิศทาง (flow line) 

คือ ทิศทางขั้นตอนการด าเนินงาน 

  

3.3 ขั้นตอนของระบบงานการจัดท าบอร์ดความรู้  มี  6  ขั้นตอน ดังนี้ 
1) ค้นคว้าหาข้อมูล 

               ผู้ผลิตบอร์ดความรู้จะน าเสนอเรื่องราวหรือเนื้อหาที่ผ่านการพิจารณาจากหัวหน้างาน 

และหัวหน้าฝ่าย โดยเรื่องราวของบอร์ดความรู้นั้น มีแหล่งข้อมูลให้ค้นคว้าได้ดังนี้ 

(1) ส านักบรรณาสารของมหาวิทยาลัยสุโขทัยธรรมาธิราช ซึ่งมีต าราหนังสือ วารสาร สื่อ

โสตทัศน์ รวมทั้งการให้บริการเครือข่ายอินเทอร์เน็ต  

(2) อินเทอร์เน็ต ของฝ่ายบริการเผยแพร่ทางไกล ส านักการศึกษาต่อเนื่อง 

(3) บทความปกิณกะ ที่ผ่านการประเมิน และได้รับการเผยแพร่ทางเว็บไซต์ ส านัก

การศึกษาต่อเนื่อง 

2) เสนอหัวหน้าฝ่ายพิจารณา   

ผู้ผลิตบอร์ดความรู้  น าบทความที่เรียบเรียงเสนอหัวหน้าฝ่ายพิจารณาความถูกต้อง

ข้อมูลเนื้อหาที่เป็นปัจจุบัน  ความเหมาะสมของเนื้อหา ข้อมูลครบถ้วนสมบูรณ์  และสื่อความหมาย
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ได้ชัดเจน หากมีข้อเสนอแนะผู้ผลิตบอร์ดความรู้  ต้องปรับแก้ไข  เมื่อมีการปรับแก้ไขจะต้อง

ด าเนินการแก้ไขทันที  แต่ถ้าไม่มีการแก้ไขก็ด าเนินการออกแบบบอร์ดความรู้ได้เลย 

3) ด าเนินการออกแบบ  

      เมื่อได้รับมอบหมายงาน  จะต้องปฏิบัติงานตามที่ได้รับมอบหมายให้เสร็จตามระยะเวลา

ที่ก าหนดไว้  ทั้งนี้ต้องเผื่อเวลาการตรวจสอบและการแก้ไขไว้ด้วย  ในกรณีงานออกแบบบอร์ดความรู้

นั้น  จะมีรายละเอียดต่างๆ  ที่จะต้องหาข้อมูลเพ่ิมเติมหรือจะต้องค้นคว้าหารูปภาพที่เกี่ยวข้องกับ

เนื้อหาความรู้นั้นๆ  โดยค านึงถึงหลักการออกแบบความสวยงาม  ความรวดเร็วและความถูกต้อง  

เมื่อด าเนินการแล้วเสร็จจะต้องบอกแหล่งที่มาของข้อมูลนั้นด้วย  พร้อมทั้งเตรียมส าเนาบทความของ

บอร์ดไว้ ส าหรับผู้สนใจทั่วไปต้องการข้อมูล  ตอนท้ายของบอร์ดความรู้บอกถึงผู้จัดท าโดย  ฝ่าย

บริการเผยแพร่ทางไกล  ส านักการศึกษาต่อเนื่อง   

4) พิสูจน์อักษร 

      พิสูจน์อักษรท าหน้าที่อ่านบทความนั้น และตรวจทานความถูกต้องเรื่องตัวสะกด การเว้น

วรรค ชื่อบุคคลที่เป็นข่าว แหล่งข่าว หลักๆ ก็คือการตรวจดูความเรียบร้อยของอักษร ทั้งค า วลี 

ประโยค ตั้งแต่การสะกดค า การวางประโยค การไม่ใช้ส านวนต่างประเทศ  การใช้ค าฟุ่มเฟือยต่างๆ 

การใช้ค าซ้ าๆ ไม่สละสลวย  และบางครั้งอาจหมายรวมถึงการเปลี่ยนแปลงประโยคให้สละสลวย การ

ใช้ค าสลับกัน การหลากค าในกรณีที่ผู้เขียนใช้ค ามาซ้ าๆ กัน เพ่ือให้ข้อเขียนนั้น อ่านแล้วราบรื่น ไม่

สะดุด เป็นต้น ตัวอย่างเช่น สถานการณ์ อุทกภัยน้ าท่วม ค าว่า อุทกภัย และค าว่าน้ าท่วม มี

ความหมายเดียวกัน เราสามารถเลือกใช้เพียงหนึ่งค าได้ หรือการใช้ค าเชื่อมซ้ าๆ เช่น  วันนี้ฉันต้องตื่น

เช้าไปออฟฟิศ ซึ่ง ตั้งอยู่ย่านถนนวิภาวดีรังสิต ซึ่ง ตั้งอยู่ใกล้กับห้างเซ็นทรัลลาดพร้าว ฯลฯ 

ตรวจสอบหลากค าเชื่อมที่ซ้ านั้นให้อ่านแล้วไม่สะดุดได้ ค าเชื่อมหลักๆ ที่ใช้ ประจ า เช่น ที่ ซึ่ง อัน เมื่อ 

เนื่องจาก นอกจากนี้ นอกจากนั้น เป็นต้น นอกจากการดูเรื่องของตัวสะกด การใช้ค า การใช้ประโยค

แล้ว การใช้เครื่องหมายวรรคตอน และการเว้นวรรคก็เป็นเรื่องส าคัญประการหนึ่ง ที่จะต้องจัดให้อ่าน

ง่าย สบายตา  

5) ตรวจสอบงานโดยหัวหน้าฝ่าย 

                ตรวจสอบความถูกต้องสวยงาม หลังจากที่ด าเนินการค้นคว้าหาข้อมูลจากแหล่งข้อมูล

และออกแบบภาพประกอบบทความนั้นเรียบร้อยสมบูรณ์ เสร็จแล้ว  จ าเป็นต้องตรวจสอบความ

ถูกต้องโดยหัวหน้าฝ่ายบริการเผยแพร่ทางไกลเป็นผู้ตรวจสอบและพิจารณาข้อมูลเนื้อหาที่เป็น
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ปัจจุบัน  ความเหมาะสมและความชัดเจนของเนื้อหาครบถ้วนสมบูรณ์ และสื่อความหมายได้ชัดเจน

ถูกต้อง และมีการตรวจทานหรือแก้ไขข้อมูลให้ถูกต้องเชื่อถือได้ 

 6) ผลงานส าเร็จ 

      เมื่อผ่านกระบวนการตรวจสอบหรือแก้ไขเรียบร้อย  ด าเนินการออกแบบและตรวจสอบ

ความถูกต้องครบถ้วนสมบูรณ์แล้ว  ด าเนินการส่งพิมพ์งาน เพ่ือจะได้น าไปเผยแพร่ความรู้ต่อไป 

7) เผยแพร่ความรู้   

               เมื่อด าเนินการส่งร้านปริ้นไวนิล และได้รับงานเรียบร้อยแล้ว  ท าการติดตั้งบอร์ด น าป้าย

ไวนิลมายึดติดกับบอร์ดที่เตรียมไว้ น าเสนอบอร์ดความรู้ติดตั้ง ณ หน้าส านักการศึกษาต่อเนื่อง 

มหาวิทยาลัยสุโขทัยธรรมาธิราช และน าเสนอข้ึนเว็บไซด์ผ่านทางการประชาสัมพันธ์โครงการสัมฤทธิ-

บัตร ของฝ่ายบริการเผยแพร่ทางไกล ซึ่งเป็นบริการวิชาการแก่สังคม  เมื่อเสร็จสิ้นการน าเสนอบอร์ด

ความรู้ในแต่ละครั้ง ทางฝ่ายบริการเผยแพร่ทางไกล ได้ท าแบบสอบถามประเมินบอร์ดความรู้ โดย

ผ่านช่องทางอินเตอร์เน็ต และภายในมหาวิทยาลัยโดยขอส าเนาบทความ และท าแบบสอบถามพร้อม

แจกของที่ระลึกให้กับผู้สนใจทั่วไป เมื่อได้อ่านบอร์ดความรู้แล้วมีความพึงพอใจอยู่ในระดับใด มีความ

คิดเห็นและข้อเสนอแนะอย่างไร ผู้ปฏิบัติจะได้น ามาปรับปรุงเพ่ือเป็นแนวทางในการน าเสนอครั้ง

ต่อไป หลังจากเผยแพร่ความรู้ครบตามก าหนดเวลา ได้จัดเก็บรวบรวมบอร์ดความรู้ทั้งหมดจัดส่ง

เผยแพร่ต่อประชาชนทั่วไป  โดยการจัดส่งไปยังศูนย์วิทยพัฒนา มหาวิทยาลัยสุโขทัยธรรมาธิราช 

จ านวน 10 ศูนย์ ขอความอนุเคราะห์ติดบอร์ดเผยแพร่ความรู้ 

 

 

 

 

 

 

 

 



บทที่ 4 

ขั้นตอน วิธีการปฏิบัติงาน 
การจัดท าบอร์ดความรูด้้วยโปรแกรม Adobe Photoshop CS6 

 
การสร้างความคิด  และการแสดงออกของมนุษย์เกี่ยวกับการออกแบบ  มีความแตกต่างกัน

ไปตามศักยภาพในกระบวนการคิด  และสติปัญญาของแต่ละบุคคล  ทั้งนี้มีการสร้างสรรค์งานรูปแบบ

ใหม่ๆ  ขึ้นมา  ภายไต้แรงบันดาลใจของผู้ออกแบบ  โดยจะต้องค านึงถึงความต้องการ  ความสวยงาม  

ความกลมกลืนของรูปทรง  สี  และการน าองค์ประกอบต่างๆ ได้แก่ รูปภาพประกอบ (Illustration) 

ภาพถ่าย (Photography) สัญลักษณ์ (Symbol) รูปแบบและขนาดตัวอักษร มาจัดวางเพ่ือแสดง

คุณค่าทางการออกแบบอย่างตรงไปตรงมา ให้เกิดการน าเสนอข้อมูลอย่างชัดเจน 

บรรทัดฐานการออกแบบกราฟฟิก Graphic Design  

บรรทัดฐานในงานออกแบบมีหลักอยู่ 3 ข้อ ได้แก่ 

1. การตอบสนองประโยชน์ใช้สอย (Function) เป็นข้อส าคัญมากในการออกแบบทั้งหมด ใน

งานออกแบบกราฟิก ประโยชน์ใช้สอยมีอิทธิพลกับงานที่เราออกแบบ เช่น การออกแบบบอร์ดความรู้ 

ตัวหนังสือต้องอ่านง่าย ชัดเจน  

2. ความสวยงามพึงพอใจ (Aesthetic) การใช้ความงามเป็นเกณฑ์ตัดสินคุณค่าของงานโดย

เฉพาะงานออกแบบกราฟิก เน้นความรู้สึกและความพึงพอใจมากกว่าการออกแบบที่มีประโยชน์ใช้

สอย 

3. การสื่อความหมาย (Meaning) งานศิลปะนั้นจะมีคุณค่าก็ต่อเมื่อมันสื่อความหมายออกมา

ได้ งานกราฟิกก็คืองานศิลปะเช่นกัน การสื่อความหมายจึงเป็นสิ่งที่นักออกแบบขาดเสียไม่ได้ในการ

ออกแบบ ต่อให้งานที่ได้สวยงามอย่างไร แต่ไม่สามารถตอบโจทย์ของงานออกแบบ หรือสื่อสิ่งที่

ผู้ออกแบบคิดเอาไว้ได้ งานกราฟิกนั้นก็จะมีคุณค่าลดน้อยลงไป 

การออกแบบและจัดท าบอร์ดความรู้โดยฝ่ายบริการเผยแพร่ทางไกลนั้น  มีหน้าที่รับผิดชอบ

การให้บริการทางวิชาการแก่สังคมโดยการเผยแพร่ความรู้สู่ประชาชนผ่านสื่อและกิจกรรมทางวิชาการ 

เป็นงานบริการวิชาการแก่สังคมเพ่ือส่งเสริมการเรียนรู้ตลอดชีวิต เป็นยุทธศาสตร์ด้านการพัฒนาและ

เสริมสร้างศักยภาพบุคคล กระจายโอกาสและความเสมอภาคทางด้านการศึกษา ด้วยการเรียนรู้ด้วย
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ตนเองผ่านสื่อการสอนต่างๆ  โดยไม่มีอุปสรรคด้านเวลาและสถานที่เป็นการเปิดโอกาสให้ทุกคน  ไม่

จ ากัดวัยและวุฒิการศึกษาได้เพ่ิมพูนความรู้และพัฒนาทักษะทางวิชาการ  และสามารถน าความรู้ที่

ได้รับไปพัฒนาและยกระดับคุณภาพชีวิต เพ่ิมประสิทธิภาพในการปฏิบัติงาน  ตามความสนใจ  ยึด

หลักการศึกษาตามอัธยาศัยตลอดชีวิต และการจัดกระบวนการจัดท าบอร์ดความรู้ ของส านัก

การศึกษาต่อเนื่องนั้นถือว่าเป็นส่วนส าคัญส่วนหนึ่งของการเผยแพร่ความรู้  จากภาระงานที่ได้รับ

มอบหมายหลายอย่างตามข้างต้นนั้น  ผู้จัดท าจึงได้น าเอาเรื่องการจัดท าบอร์ดความรู้  มาจัดท าเป็น

คู่มือการปฏิบัติงานขึ้นมา โดยมีขั้นตอนการปฏิบัติงานอย่างครบถ้วนสมบูรณ์ เพ่ือให้ผู้บริหารหัวหน้า

งานสามารถทราบขั้นตอนการปฏิบัติงาน และผู้ปฏิบัติรุ่นต่อไปสามารถน าไปปฏิบัติตามได้อย่าง

ถูกต้อง  รวดเร็วและเป็นระบบ ดังนี้ 

 

1. การค้นคว้าหาข้อมูลน าเสนอเพื่อท าบอร์ดความรู้ 

การวางแผนในการน าเสนอเรื่องขึ้นบอร์ด ควรค้นคว้าหาข้อมูลที่เป็นปัจจุบัน ให้ทัน

เหตุการณ์ในยุคประจ าวัน  คอยติดตามข่าวสารต่าง ๆ เช่น ข่าวเศรษฐกิจ ข่าวบ้านเมือง ข่าวเกี่ยวกับ

เครื่องมือ อิเล็กโทรนิคต่างๆ  ข่าวการศึกษา เป็นต้น โดยข้อมูลนั้นต้องเป็นเรื่องที่คนส่วนใหญ่สนใจ 

และน าไปใช้ให้เกิดประโยชน์สูงสุดได้อย่างเป็นรูปธรรม อาจจะแยกความสนใจประเภทของผู้อ่านเป็น

กลุ่ม เกี่ยวข้องกับผู้สูงอายุ วัยรุ่น วัยท างาน วัยเกษียณ หรือความรู้ทั่วไปที่ทุกคนสนใจในเรื่องเดียวกัน 

เช่น เรื่องเกี่ยวกับดิจิทัลเป็นเรื่องที่น่าสนใจในยุคนี้  ผู้ปฏิบัติสามารถหาข้อมูลข่าวสารทีเป็นสื่อดิจิทัล

มาน าเสนอ ข้อดี ข้อเสีย ประโยชน์ และบทสรุป การค้นคว้าหาข้อมูลมีที่สืบหาหลายช่องทาง และ

วิธีการสืบค้นที่แตกต่างกัน เช่น ห้องสมุด ทางอินเตอร์เน็ต สอบถามผู้รู้ (สัมภาษณ์) ดังนั้นเพ่ือให้

เข้าถึงแหล่งข้อมูลที่ต้องการอย่างแท้จริง ต้องรู้วิธีการสืบค้นเพื่อความสะดวก รวดเร็วและท่ีส าคัญตรง

กับความต้องการ ตัวอย่างแหล่งข้อมูลที่ส าคัญที่ใช้เป็นประจ ามี ดังนี้  

ห้องสมุด มีหนังสือมากมายแบ่งเป็นหมวดหมู่ มีเจ้าหน้าที่คอยช่วยเหลือและให้บริการ เป็น

สถานที่รวบรวมสรรพวิทยาการต่าง ๆ หลายสาขา ซึ่งได้บันทึกไว้ในรูปของหนังสือ วารสาร ต้นฉบับ

ตัวเขียน สิ่งตีพิมพ์อ่ืนๆ หรือโสตทัศนวัสดุ และมีการจัดระเบียบเพ่ือสะดวกแก่การค้นคว้าและบริการ 

และเป็นแหล่งสืบค้นข้อมูลที่มหาวิทยาลัยมีอยู่แล้ว แยกตามหมวดหมู่ เป็นแหล่งข้อมูลที่มีความ

หลากหลาย  
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การค้นหาข้อมูลความรู้จะสะดวกส าหรับผู้ปฏิบัติ  อีกช่องทางหนึ่งคือการหาความรู้ทาง

อินเทอร์เน็ต ซึ่งมีความหลากหลายและน่าสนใจอยู่มากมายทันต่อเหตุการณ์ปัจจุบัน สามารถค้นหาได้ 

24 ชั่วโมง สืบค้นหาข้อมูลได้ไม่ยากสะดวกและรวดเร็ว มีข้อมูลให้เปรียบเทียบหลายแหล่ง อยู่ที่การ

สืบค้นของผู้ปฏิบัติ ในคู่มือเล่มนี้ผู้ปฏิบัติขอแนะแนวทางและวิธีในการหาข้อมูลความรู้ด้วยระบบ

อินเทอร์เน็ต 

ผู้เขียนคู่มือได้น าเสนอการค้นหาข้อมูล  2 วิธี ดังนี้ 

                 1. การค้นหาในรูปแบบ Index Directory  

                 2. การค้นหาในรูปแบบ Search Engine   

1. การค้นหาในรูปแบบ Index Directory   

1.1 พิมพ์ข้อความที่จะค้นหา 

1.2 คลิกเลือกแท็บ Directory 

1.3 คลิกเลือกเนื้อหาไปตามล าดับหัวข้อ เลือก Education  

 

 

 

 

 

 

 

 

 

 

   พิมพ์ค าค้นแล้วคลิกเลือกแท็บ Directory                     คลิกเลือกเนื้อหาไปตามล าดับหัวข้อ 

     ข้อเด่นของ Directory คือ เหมาะในการค้นหาเรื่องทั่วๆ ไปมากกว่าเรื่องที่มีความเฉพาะเจาะจง   

         ภาพที่ 6 ตัวอย่างการค้นหาในรูปแบบ Index Directory 
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2. การค้นหาในรูปแบบ Search Engine  ตัวอย่างเช่น http://www.google.co.th/,  

http://www.youtube.com/,  http://dict.longdo.com 

              การสืบค้นเว็บไซต์ข้อมูลด้วย Search Engine 

           2.1 ท าการเปิดเว็บไซต์ที่ให้บริการ http://www.google.co.th/ 

           2.2 เลือกหัวข้อที่ต้องการค้น ในที่นี้จะเลือกหัวข้อ “เว็บ” 

           2.3 พิมพ์ keyword (ข้อความ) ที่ต้องการสืบค้นลงในช่อง text box 

           2.4 กดท่ีปุ่ม “ค้นหา” 

           2.5 ระบบจะท าการค้นหาเว็บไซต์ที่ตรงกับ keyword ที่ต้องการ และแสดงออกมา

ในรูปแบบของลิ้งค์พร้อมค าอธิบายประกอบ ดังภาพที่ 7 ตัวอย่างการค้นหาในรูปแบบ Search 

Engine 

 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 7 ตัวอย่างการค้นหาในรูปแบบ Search Engine 

 

เทคนิคที่ควรรู้ในการค้นหาข้อมูล 

  ในการค้นหาข้อมูลด้วย Search Engine ส่วนใหญ่แล้วปัญหาที่ผู้ใช้งานทั่วไปมักจะพบเห็น 

หรือประสบอยู่เสมอๆ  ข้อมูลที่ค้นหาได้มีขนาดมากจนเกินไป  ดังนั้นเพื่อความสะดวกในการใช้งานจึง

http://www.google.co.th/
http://www.youtube.com/
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น่าที่จะเรียนรู้เทคนิคต่างๆ เพ่ือช่วยลดหรือจ ากัดค าที่ค้นหาให้แคบลงและตรงประเด็นมากที่สุด  ดัง

วิธีการต่อไปนี้ 

1. เลือกรูปแบบการค้นหาให้ตรงกับสิ่งที่ต้องการมากท่ีสุด 

2. ใช้ค ามากกว่า 1 ค าท่ีมีลักษณะเกี่ยวข้องกันช่วยค้นหา เพราะจะได้ผลลัพท์ท่ีมีขนาด               

แคบลงและชี้เฉพาะมากขึ้น (ย่อมจะดีกว่าหาค าเดียวโดดๆ) 

3. ใช้บริการของผู้ให้บริการเฉพาะด้าน  เช่น การค้นหาข้อมูลเกี่ยวกับเรื่องราวของอาเซียน 

ก็น่าที่จะเลือกใช้ Search Engine ที่ให้บริการใกล้เคียงกับเรื่องพวกนี้ เพราะผลลัพท์ที่ได้น่าจะเป็นที่

น่าพอใจกว่า 

4. ใส่เครื่องหมายค าพูดครอบคลุมกลุ่มค าที่ต้องการ เพ่ือบอกกับ Search Engine ต้องการ 

ผลการค้นหาที่มีค าในกลุ่มนั้นครบและตรงตามล าดับที่พิมพ์ทุกค า เช่น "free shareware" เป็นต้น 

5. หลีกเลี่ยงการใช้ตัวเลข พยายามเลี่ยงการใช้ค าค้นหาที่เป็นค าเดี่ยวๆ หรือเป็นค าที่มี                

ตัวเลขปน แต่ถ้าเลี่ยงไม่ได้ ก็อย่าลืมใส่เครื่องหมายค าพูด (" ") ลงไปด้วย เช่น "windows 98" 

6. หลีกเลี่ยงภาษาพูด หลีกเลี่ยงค าประเภท Natural Language หรือเรียกง่ายๆ ว่าค าหรือ 

ข้อความที่เป็นภาษาพูด หรือเป็นประโยค ควรสรุปเป็นเพียงกลุ่มค าหรือวลี ที่มีความหมายรวม

ทั้งหมดไว้ Advanced Search อย่าลืมที่จะใช้ Advanced Search เพราะจะมีส่วนช่วยได้มาก  ใน

การบบีประเด็นหัวข้อให้แคบลง  ซึ่งจะท าให้ได้รายชื่อเว็บไซต์ที่ตรงกับความต้องการมากข้ึน                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                 

7. อย่าละเลย Help ซึ่งในแต่ละเว็บ จะมี ปุ่ม help หรือ Site map ไว้คอยช่วยเหลือคุณ 

แต่คนส่วนใหญ่มักจะมองข้ามซึ่ง help/site map จะมีประโยชน์มากในการอธิบาย option หรือการ

ใช้งาน/แผนผังปลีกย่อยของแต่ละเว็บไซต์  

การใช้งาน  Google ในการค้นคว้าหาข้อมูล 

 เมื่อพิมพ์ที่อยู่ www.google.co.th ลงในช่อง Address แล้วกด Enter  จะปรากฏหน้า

แรกของ Web Site ซึ่งจะมีส่วนประกอบต่าง ๆ ดังรูป 
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ภาพที่ 8 รูปแสดงส่วนประกอบต่างๆ ในหน้าค้นหาของ www.google.co.th 

โดยท่ีมีส่วนประกอบต่างๆ คือ 

1)   เป็น Logo ของ www.google.co.th 

2) เป็นประเภทของการค้นหาว่าให้ค้นหาข้อมูลที่อยู่ในเว็บ (Web Site) 

3) เป็นประเภทของการค้นหาว่าให้ค้นหาข้อมูลที่เป็นรูปภาพ 

4) เป็นประเภทของการค้นหาที่แยกตามกลุ่มข่าวเรียงตาม Usenet 

5) เป็นประเภทของการค้นหาโดยจะแยกเป็นหมวดหมู่ต่าง ๆ เช่น Arts, Home,  

Business, Games เป็นต้น ซึ่งตัวเลือกในข้อ 2-5 เมื่อเรากดคลิกที่แถบใดแถบหนึ่งก็จะปรากฏเป็น

แถบเข้มที่เราเลือกไว้ โดยปกติแล้วเมื่อเราเปิดหน้าแรกขึ้นมา Web Site google จะก าหนดการ

ค้นหาให้ไว้ที่เว็บ 

6) เป็นช่องส าหรับใส่ค า (keyword) ที่เราต้องการค้นหา 

7) เป็นปุ่มกดส าหรับเริ่มการค้นหา 

8) เป็นปุ่มส าหรับค้นหาเว็บอย่างด่วน  โดยการค้นหาจะน าเว็บที่อยู่ล าดับแรกท่ีค้นหา 

พบมาเปิดให้ในหน้าถัดไปเลย 

9) เป็นตัวเลือกส าหรับการค้นหาแบบละเอียดโดยในตัวเลือกนี้จะมีการก าหนดเงื่อนไข 

ในการค้นหาเพื่อให้ได้ผลการค้นหาที่ละเอียดยิ่งขึ้น เช่น ภาษา, ชนิดไฟล์, วันที่ เป็นต้น 

10)  เป็นตัวเลือกส าหรับการปรับแต่งตัวเลือกใช้ส าหรับการปรับแต่งรูปแบบเครื่องมือใน 

การค้นหา เช่น จ านวน เว็บทีแ่สดงในการค้นหาต่อหน้า 

11)  เป็นตัวเลือกส าหรับการปรับเปลี่ยนภาษาใช้เป็นเครื่องมือในการค้นหา    

1 
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 การค้นหาจะแจ้งจ านวนเว็บที่แสดง จ านวนเว็บที่พบ และเวลาที่ใช้ในการค้นหา ในกรณทีี ่

การค้นหาพบข้อมูลมากกว่าที่จะแสดงได้หมดใน 1 หน้า ทาง www.google.co.th ก็จะแสดงหน้า

ถัดไปได้โดยสามารถคลิ๊กหน้าต่อไปที่ตอนล่างของหน้า Web Site 

 Google จะสามารถค้นหาไฟล์ในรูปแบบอื่น ๆ โดยประเภทไฟล์ที่รองรับคือ 

- Adobe Portable Document Format (มีนามสกุล เป็น pdf) 

- Adobe Post Script (มีนามสกุลเป็น ps) 

- Lotus 1-2-3 (มีนามสกุลเป็น wk1, wk2, wk3, wk4, wk5, wki, wks, wku) 

- Lotus Wordpro (มีนามสกุลเป็น lwp) 

- MacWrite (มีนามสกุลเป็น mw) 

- Microsoft Word (มีนามสกุลเป็น doc) 

- Microsoft Excel (มีนามสกุลเป็น xls) 

- Microsoft Power Point (มีนามสกุลเป็น ppt ) 

- Text File  (มีนามสกุลเป็น txt ) 

  

 สามารถค้นหาโดยระบุชนิดของไฟล์ที่ต้องการค้นหาได้โดยใช้ค าว่า filetype : แล้วตาม

ด้วยนามสกุลของไฟล์ที่ต้องการค้นหา เช่น 

 

 

 

 

 

   ค้นหาได้โดยใช้ค่าว่า filetype : แล้วตามด้วยนามสกุลของไฟล์ 

               

 ซึ่งสามารถ download มาเก็บไว้ในเครื่องได้โดยคลิกเมาส์ขวาแล้วเลือกแถบ Save 

Target As Google  สามารถตัดค าที่เป็นค าพ้องรูปโดยใช้เครื่องหมาย  “   -   ” เช่นค าว่า bass มี

ความหมายเกี่ยวกับปลาและดนตรี ในเวลาที่ต้องการตัดความหมายเกี่ยวกับดนตรีก็ท าได้โดยพิมพ์ว่า 
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bass-music  นอกจากนี้ยังสามารถตัดชนิดของไฟล์ที่ต้องการค้นหาได้ เช่น ต้องการค้นหาค าว่า bass 

โดยตัดการค้นหาชนิดไฟล์ที่เป็น pdf ออกก็ท าได้โดยพิมพ์ bass -filetype : pdf 

 Google สามารถค้นหา  link  ทั้งหมดท่ีเชื่อมไปยัง Website นั้น โดยใช้ค าว่า link : แล้ว

ตามด้วยชื่อ Website นั้น เช่น link : www.google.com 

 

 

 

 

 

 

 

 

ภาพที่ 9 แผนความคิดแสดงลักษณะของข้อมูลที่น่าเชื่อถือ 

 

 1.2 เสนอหัวหน้าฝ่ายบริการเผยแพร่ทางไกลพิจารณา 

      หลังจากที่ด าเนินการค้นคว้าหาข้อมูลจากแหล่งข้อมูลเสร็จแล้ว  จ าเป็นต้องตรวจสอบ

ความถูกต้องของข้อมูล มีระบบอ้างอิงตามมาตรฐานที่สามารถตรวจสอบข้อมูลได้ และมีการ

ตรวจทานหรือแก้ไขข้อมูลให้ถูกต้องเชื่อถือได้เพราะหากข้อมูลไม่น่าเชื่อถือแล้ว  สารสนเทศที่ได้จาก

ข้อมูลนั้นก็ไม่น่าเชื่อถือด้วย  เสนอหัวหน้าฝ่ายบริการเผยแพร่ทางไกลพิจารณา พิจารณาตรวจสอบ

ความถูกต้องและพิจารณาข้อมูลเนื้อหาที่เป็นปัจจุบัน  ความเหมาะสมและความชัดเจนของเนื้อหา

ข้อมูลครบถ้วนสมบูรณ์  และสื่อความหมายได้ชัดเจนถูกต้อง  เมื่อมีการปรับแก้ไขจะต้องด าเนินการ

แก้ไข  แต่ถ้าไม่มีการแก้ไขก็ด าเนินการออกแบบทันที  

 

1.3 ด าเนินการออกแบบ 

     เมื่อได้รับมอบหมายงาน  จะต้องปฏิบัติงานตามที่ได้รับมอบหมายให้เสร็จตามระยะเวลาที่

ก าหนดไว้ ทั้งนี้ต้องเผื่อเวลาการตรวจสอบและการแก้ไขไว้ด้วย ในกรณีงานออกแบบบอร์ดความรู้นั้น 

จะมีรายละเอียดต่างๆ ที่จะต้องหาข้อมูลเพ่ิมเติมหรือจะต้องค้นคว้าหารูปภาพที่เกี่ยวข้องกับเนื้อหา
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ความรู้นั้นๆ  เมื่อด าเนินการแล้วเสร็จต้องบอกแหล่งที่มาของข้อมูลด้วย  พร้อมทั้งเตรียมส าเนา

บทความของบอร์ดส าหรับผู้สนใจทั่วไปต้องการข้อมูล   ตอนท้ายของบอร์ดความรู้บอกถึงผู้จัดท าโดย  

ฝ่ายบริการเผยแพร่ทางไกล  ส านักการศึกษาต่อเนื่อง  และส่งงานไปให้หัวหน้าฝ่ายฯ  ตรวจสอบ

ความถูกต้องต่อไป 

 

1.4 พิสูจน์อักษร 

    พิสูจน์อักษรท าหน้าที่อ่านบทความนั้น  และตรวจทานความถูกต้องเรื่องตัวสะกด  การ

เว้นวรรค  ชื่อบุคคลที่เป็นข่าว  แหล่งข่าวหลักๆ ก็คือการตรวจดูความเรียบร้อยของอักษร ทั้งค า วลี 

ประโยค ตั้งแต่การสะกดค า  การวางประโยค  การไม่ใช้ส านวนต่างประเทศ  การใช้ค าฟุ่มเฟือยต่างๆ 

การใช้ค าซ้ าๆ ไม่สละสลวย  และบางครั้งอาจหมายรวมถึงการเปลี่ยนแปลงประโยคให้สละสลวย  การ

ใช้ค าสลับกัน  การหลากค าในกรณีที่ผู้เขียนใช้ค าซ้ าๆ กันเพ่ือให้ข้อเขียนนั้นอ่านแล้วราบรื่นไม่สะดุด 

เป็นต้น  

 

 1.5 ตรวจสอบความถูกต้องโดยหัวหน้าฝ่าย 

    หลังจากที่ด าเนินการออกแบบเสร็จแล้วจะต้องมีการตรวจสอบความถูกต้องของชิ้นงาน 

การตรวจสอบงานส าเร็จ หัวหน้าฝ่ายบริการเผยแพร่ทางไกลเป็นผู้ตรวจสอบความถูกต้องของเนื้อหา 

ความเหมาะสมของรูปภาพความชัดเจนของรูปแบบ เมื่อมีการปรับแก้ไขจะต้องด าเนินการแก้ไขทันที 

ถ้าไม่มีการแก้ไขใดๆ แล้ว ด าเนินการจัดพิมพ์ตามจ านวนที่ก าหนด 

 

1.6 ผลงานส าเร็จ 

   เมื่อผ่านกระบวนการตรวจสอบหรือแก้ไขเรียบร้อย  ด าเนินการออกแบบและตรวจสอบ

ความถูกต้องครบถ้วนสมบูรณ์แล้ว  ด าเนินการส่งพิมพ์งาน เพ่ือจะได้น าไปเผยแพร่ความรู้ต่อไป  

ผู้ปฏิบัติงานจะต้องส่งไฟล์งานพิมพ์ไปยังร้านที่รับปริ้นงานไวนิล  ทุกขั้นตอนของการท างานต้องรีบ

ด าเนินการด้วยความรวดเร็ว  แต่ก็ต้องมีความถูกต้องและสวยงามด้วยจึงจะถือว่าเป็นงานที่ดีมี

คุณภาพ 
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1.7 การเผยแพร่บอร์ดความรู้ 

เมื่อผลงานส าเร็จเรียบร้อยแล้วด าเนินการส่งร้านปริ้นไวนิล เหตุผลที่จ าเป็นต้องเลือกวัสดุ

ชนิดนี้ เพราะทนทานต่อแสงแดดและน้ าฝน ซึ่งจัดแสดงบอร์ดได้เป็นเวลานาน อีกทั้งบอร์ดความรู้มี

สีสันสดใส  ได้รับงานเรียบร้อยแล้วท าการติดตั้งบอร์ด ที่มีขนาด 230 เซนติเมตร X 230 เซนติเมตร 

น าป้ายไวนิลมายึดติดกับบอร์ดที่เตรียมไว้หรือที่เรียกว่า PULL FAME น าเสนอบอร์ดความรู้ติดตั้ง ณ 

หน้าส านักการศึกษาต่อเนื่อง มหาวิทยาลัยสุโขทัยธรรมาธิราช และน าเสนอขึ้นเว็บไซด์ผ่านทางการ

ประชาสัมพันธ์โครงการสัมฤทธิบัตร ของฝ่ายบริการเผยแพร่ทางไกล เป็นการบริการวิชาการแก่สังคม  

เมื่อเสร็จสิ้นการน าเสนอบอร์ดความรู้ ในแต่ละครั้ ง ทางฝ่ายบริการเผยแพร่ทางไกล  ได้ท า

แบบสอบถามประเมินบอร์ดความรู้ โดยผ่านช่องทางอินเตอร์เน็ต และภายในมหาวิทยาลัยโดยขอ

ส าเนาบทความ และท าแบบสอบถามพร้อมแจกของที่ระลึกให้กับผู้สนใจทั่วไป เมื่อได้ อ่านบอร์ด

ความรู้แล้วมีความพึงพอใจอยู่ในระดับใด มีความคิดเห็นและข้อเสนอแนะอย่างไร ผู้ปฏิบัติจะได้น ามา

ปรับปรุงเพ่ือเป็นแนวทางในการน าเสนอครั้งต่อไป หลังจากเผยแพร่ความรู้ครบตามก าหนดเวลา ได้

จัดเก็บรวบรวมบอร์ดความรู้ทั้งหมดจัดส่งเผยแพร่ต่อประชาชนทั่วไป  โดยการจัดส่งไปยังศูนย์วิทย-

พัฒนา มหาวิทยาลัยสุโขทัยธรรมาธิราช จ านวน 10 ศูนย์ ท าบันทึกจดหมายส่งออกขอความ

อนุเคราะห์ติดบอร์ดเผยแพร่ความรู้ต่อไป 

 

 

 

 

 

 

 

 

 

 

 

 



40 

 

  

2. ขั้นตอนการออกแบบบอร์ดความรู้ด้วยโปรแกรม Adobe Photoshop CS6 

ผู้เขียนคู่มือได้ใช้ความรู้ ความสามารถ และประสบการณ์จากการท างาน 24 ปี ได้เขียน

ขั้นตอนการออกแบบบอร์ดความรู้อย่างละเอียดเพ่ือเป็นแนวทางในการปฏิบัติงาน เป็นส่วนหนึ่งใน

การบันทึกข้อมูลสารสนเทศ เรื่องดังกล่าว และยังส่งเสริมการให้การปฏิบัติงานมีประสิทธิภาพมาก

ยิ่งขึ้นต่อไป  

2.1 ขั้นตอนการสร้างช้ินงานใหม่ด้วยโปรแกรม Adobe Photoshop CS6 

                2.1.1 การเปิดและการก าหนดค่าต่างๆ ท าการเปิดโปรแกรม Adobe Photoshop 

CS6 ขึ้นมาโดยคลิ๊กที่  Programs> Adobe Photoshop CS6 ดับเบิ้ลคลิ๊ก 

            1) เข้าสู่โปรแกรม Adobe Photoshop CS6 Click Icon บน Desktop 

 

 

 

 

 

     1 

ดบัเบิล้คลิก๊ 

 

จะปรากฏหน้าต่างของโปรแกรม Adobe Photoshop CS6 ดังภาพ 
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2) สร้างงานใหม่โดยน าเม้าท์ไปคลิกที่เมนู File 

3) ค าสั่ง New หรือกด (Ctrl + N) ตรงแป้นพิมพ์ Keyboard 

                     4) เกิดหน้าต่าง NEW 
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            5) ก าหนดขนาดของบอร์ดเป็นเซนติเมตร Width 230 cm. Height 230 cm.  

  6) ตั้งชื่องานเป็น บอร์ดความรู้ 

  7) ตั้งค่ากระดาษ (Preset) เป็น Coustom 

  8) ค่าความละเอียด (Resolution) 100 pixels/inch  

  9) ตั้งค่า Color Mode เป็น CMYK 

                    10)  คลิกปุ่ม ok ดังภาพ 

 

             

            11) จะปรากฏหน้าต่างตามขนาดที่ก าหนด ดังภาพ 
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Width     ก าหนดความกว้างของภาพ โดยช่องด้านหลังเป็นการก าหนดหน่วยวัด ความกว้าง  

 Height    ก าหนดความสูงของภาพ โดยหน่วยวัดจะเป็นไปตามที่ก าหนดความกว้าง  

Resolution  ก าหนดความละเอียดของภาพ  

Color Mode  ก าหนดโหมดสีของภาพ เช่น RGB จะใช้ในงานกราฟิก ส าหรับเว็บไซด ์และ 

ภาพเคลื่อนไหว CMYK จะเหมาะส าหรับงานสิ่งพิมพ์ต่างๆ โดยจ านวนบิต ด้านหลังคือจ านวนของสีที่

ใช้ยิ่งค่ามาก สีจะยิ่งเหมือนจริงขึ้น แต่ไฟล์จะใหญ่ขึ้น  

Background Content   ก าหนดสีพ้ืนหลังของภาพ ซึ่งสามารถก าหนดเป็น สีขาว (White)  

สีพื้นหลัง (Background Color) และโปร่งใส (Transparent) 

2.1.2  การสร้างสีพ้ืนหลัง (Background) 

1) การสร้างสีพ้ืนหลังโดยเลือกภาพที่จะน ามาใช้ในงานออกแบบ ปัจจุบันสามารถ 

ค้นคว้าได้ในอินเตอร์เน็ตจากเว็บไซด์ www.google.com  มีภาพสวยๆ ให้เลือกมากมาย  หรือจาก

ภาพถ่ายที่เราเก็บไว้ในคลังรูปภาพ สามารถน ามาใช้ได้ถ้าเห็นว่าเหมาะสม  วิธีการหาภาพใน

www.google.com  คีย์ข้อมูลหรือข้อความลงในช่องส าหรับพิมพ์แล้วกด Enter คลิกปุ่ม ok  ดังภาพ 

 

 

 
 

 

http://www.google.com/
http://www.google.com/
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จะปรากฏหน้าต่างตามรูปแบบลักษณะของภาพพ้ืนหลัง Background ให้เลือกมากมาย ดังภาพ 

 

          

 

2) เลือกภาพพ้ืนหลัง เมื่อได้รูปที่ต้องการแล้วคลิกขวาและใช้ค าสั่ง  Save picture  

ดังภาพ 
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ใช้ค าสั่ง Save picture น าไปไว้ที่โฟลเดอร์ Libraries > Picture  ไว้ส าหรับเก็บเป็นคลัง

ภาพของเราใช้ในการท างาน  จะเพ่ิมความสะดวกรวดเร็วในการออกแบบเรื่องอ่ืนๆ ต่อไป ดังภาพ 

 

 
 

เปิดไปท่ีงานเดิม ใช้ค าสั่ง open ที่เมนู File  ท าตามขั้นตอน ดังภาพ 
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3) ให้เปิด File open เลือก Libraries>Picture หาภาพที่ต้องการแล้วใช้ค าสั่งโดย

การคลิกที่ภาพนั้นๆ  แล้วกดปุ่ม Open เพ่ือน ารูปภาพไปใช้เป็นภาพพ้ืนหลัง Background 

ประกอบของงานที่เราออกแบบ ดังภาพ 

 

 

  4) เมื่อเปิดภาพเสร็จเรียบร้อยแล้ว วิธีตัดภาพเพ่ือไปใช้ในงานออกแบบบอร์ดความรู้ 

โดยการใช้เครื่องมือ Rectangular Marquee Tool สร้างเส้น Selection เป็นรูปสี่เหลี่ยม ดังภาพ 
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ในแต่ละเครื่องมือนั้นจะมีเครื่องมืออ่ืนๆ ที่ซ่อนอยู่ภายในอีกมากมาย  โดยสังเกตได้จากมุม

ล่างซ้ายของเครื่องมือจะมีสามเหลี่ยมเล็กๆ อยู่เราสามารถน าเม้าท์ (mouse) ไปกดค้างไว้ตรง

สามเหลี่ยมเล็กๆ เพ่ือขยาย  และเลือกเครื่องมือที่ต้องการได้ 

 

 
 

ตัวอย่างการกดค้างไว้เพ่ือที่สามเหลี่ยมเล็กๆ ขยายให้เห็น           

เครื่องมืออ่ืนๆ ที่ซ่อนไว้ 

 

 

 

 

        เครื่องมือพ้ืนฐานของโปรแกรม Adobe Photoshop CS6 กล่องเครื่องมือ Toolbox ส าหรับ

การตกแต่งภาพ ประกอบด้วยเครื่องมือต่างๆ ที่ซ่อนอยู่ภายในอีกมากมาย  ดังนี้ 

 

 

 

 

 

1. เลือกพ้ืนที่แบบรูปทรงสี่เหลี่ยม 

2. เลือกพ้ืนที่แบบรูปทรงวงกลม วงรี 

3. เลือกพ้ืนที่แบบเส้นตรงแนวนอน 

4. เลือกพ้ืนที่แบบเส้นตรงแนวตั้ง 
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ให้เปิด File Edit และ copy ภาพ ดังภาพ 

 

 
 

5) เปิดมาที ่File เดิม แล้วเลือกแถบค าสั่ง Edit > Paste ดังภาพ 
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6) ปรับขนาดของภาพที่ต้องการให้เหมาะสมโดยเลือกแถบค าสั่ ง Edit > Free 

Transform เพ่ือดึงภาพให้ย่อหรือขยาย หรือหมุนได้ตามต้องการ ดังภาพ 

 

 
 

เมือ่ย่อ-ขยายได้ตามต้องการแล้วให้กด Apply วางต าแหน่งให้สวยงามตามภาพแสดงตัวอย่างด้านล่าง 
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7) ลดสกรีนความละเอียดของภาพเป็น 50 เปอร์เซ็น จุดประสงค์เพ่ือไม่ให้ภาพพ้ืน

หลังโดดเด่นกว่าเนื้อหาที่จะน าเสนอ ดังภาพ 

 

 

จะปรากฏหน้าต่างตามรูปแบบลักษณะของภาพพ้ืนหลัง Background ดังภาพ 
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สร้างกรอบสีออกแบบด้านล่างของบอร์ดให้เป็นสีฟ้าโดยใช้เครื่องมือค าสั่ง Edit > Free Transform  

ดังภาพ 

 

 
 

ใช้เครื่องมือค าสั่ง Edit > Fill ดังภาพ 
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คลิก Foreground Color เป็นสีฟ้า  ดังภาพ 

 
 

จะปรากฏหน้าต่างตามรูปแบบลักษณะของภาพพ้ืนหลัง Background และมีขั้นสีฟ้าด้านล่าง ดังภาพ 
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2.1.3 การพิมพ์ข้อความในภาพ (Type Tool) 

1) คลิกไปที่ Layers > new > layers ดังภาพ 

2) คลิกปุม่ ok 

 

         

     3) เลือกเครื่องมือ (Type)  เมื่อน ามาคลิกที่พ้ืนที่ว่างจะเห็นเป็นเส้นกระพริบ 
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         4)  จะเห็น Layers ของตัวหนังสือ 

                                                                                     พิมพ์ตัวอักษรแนวนอน 

                                                                              พิมพ์ตัวอักษรแนวตั้ง 

                                                                              เลือกพ้ืนที่เป็นรูปตัวอักษรในแนวนอน 

                                                                              เลือกพ้ืนที่เป็นรูปตัวอักษรในแนวตั้ง 

 

ฟอนต์ตัวอักษร       รูปแบบตัวอักษร     ขนาดตัวอักษร   การวางต าแหน่งของข้อความ   ก าหนดรปูแบบตัวอักษร                                                                                          

                                     
สลับโหมดการพิมพ์ตัวอักษร 

ในแนวนอนและแนวตั้ง                      ตกแต่งขอบของตัวอักษรให้เรียบ      สีตัวอักษร        ดัดตวัอักษรให้โค้ง           

  

5)  เลือกเครื่องมือ (Type) พิมพ์ข้อความให้ครบถ้วนเสร็จแล้ว  เปลี่ยนสีตัวอักษรตาม 

ความต้องการ จะปรากฏหน้าต่างที่เปลี่ยนสีตัวอักษรเรียบร้อยแล้ว ดังภาพ 
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2.1.4 การสร้างเทคนิคเพิ่มเติมให้ตัวอักษร 

โปรแกรม Photoshop CS6 เป็นโปรแกรมที่มีความสามารถในการท าเทคนิคพิเศษให้กับ

ตัวอักษร มีลูกเล่นน่าสนใจได้หลากหลายรูปแบบ  วิธีใส่เงาให้ตัวหนังสือเพ่ือท าให้มีมิติโดยไปที่เมนู 

เลือก Layer ต้องการสร้างเทคนิคพิเศษคลิก Manu > Layer > Layer Style > Drop Shadow  

ดังภาพ 

 

 

 
  

ตั้งค่า Layer Style ตามรูปภาพแล้วคลิก ok ดังภาพ 

                     Blend Mode  :  Multiply 

         Opacity        :  85 

         Angle           :  120   

                     คลิกเลือก  Use Global Light 

           Distance  :  20 

         Spread    :  16 

         Size        :  32 
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คุณสมบัตขิองการเลือกเทคนิคแต่ละอย่างของตัวอักษร 

- Bevel and Emboss  (เอียงและท าให้มีผิวนูน) 

- Contour  (เส้นแสดงรูปร่าง) 

- Texture  (พ้ืนผิวภาพ) 

- Stroke  (การท าเส้นขอบตัวอักษร) สามารถเลือกสีและขนาดของขอบตัวอักษรได้ 

- Inner Shadow  (มีเงาภายในภาพ) 

- Inner Glow  (เรืองแสงภายใน) 

- Satin  (ลวดลายบนตัวอักษร) 

- Color Overlay  (ความทึบของสี) สามารถปรับความทึบได้ 

- Gradient Overlay  (การไล่โทนสี) สามารถเลือกโทนสีได้ 

- Pattern Overlay  (การแสดงพ้ืนผิวแบบต่างๆ) 

- Outer Glow  (เรืองแสงภายนอก) 

- Drop Shadow  (เงาที่รูปภาพ) 
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จะปรากฏหน้าต่างที่เปลี่ยนเพ่ิมเงาของตัวอักษรเรียบร้อยแล้ว ดังภาพ 

 

 
 

2.1.5 วิธีสร้างกรอบภาพส าหรับใส่เนื้อหาบทความ 

1) เลือกเครื่องมือ Rectangular Marquee Tool เพ่ือสร้างพ้ืนที่ส าหรับใส่ 

ตัวหนังสือ ลากเส้น Selection ให้เป็นรูปสี่เหลี่ยม ดังภาพ 
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2) คลิกท่ีเครื่องมือดูดสี (Eyedropper Tool) ดังภาพ 

 

                                              

                        

 

 

 

 

1. ใช้เลือกสีจากภาพไปใช้งาน 

2. ใช้ดูดสีไว้ส าหรับเปรียบเทียบค่า 

3. ใช้วัดระยะห่างและก าหนดต าแหน่ง 

4. ใช้เพิ่มค าอธิบายให้กับภาพ 

3) คลิก Foreground Color เป็นสีแดง คลิกเลือกสี Foreground Color คลิกปุ่ม  

ok  ดังภาพ 

 

https://sites.google.com/site/computeronlineinth/neuxha-bth-reiyn/-photoshop-cs5/---photoshop-cs3/8.jpg?attredirects=0
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จะปรากฏหน้าต่างที่เป็นกรอบภาพส าหรับใส่เนื้อหาบทความเรียบร้อยแล้ว ดังภาพ 

 

 

              2.1.6 สร้างเทคนิคเพิ่มเติมใหก้รอบภาพส าหรับใส่ตัวอักษร 

    โปรแกรม Photoshop CS6 เป็นโปรแกรมที่สามารถออกแบบเทคนิคพิเศษให้กับรูปทรง

ต่างๆได้หลากหลายรูปแบบ  โดยใช้หลักการเดียวกับการออกแบบตัวอักษร วิธีใส่เงาให้กรอบภาพเพ่ือ
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ท าให้มีมิติโดยไปที่เมนู เลือก Layer ต้องการสร้างเทคนิคพิเศษคลิก Manu > Layer > Layer Style 

> Drop Shadow 

- Bevel and Emboss (เอียงและท าให้มีผิวนูน) 

- Contour (เส้นแสดงรูปร่าง) 

- Texture (พ้ืนผิวภาพ) 

- Stroke (การท าเส้นขอบตัวอักษร) สามารถเลือกสีและขนาดของขอบตัวอักษรได้ 

- Inner Shadow (มีเงาภายในภาพ) 

- Inner Glow (เรืองแสงภายใน) 

- Satin (ลวดลายบนตัวอักษร) 

- Color Overlay (ความทึบของสี) สามารถปรับความทึบได้ 

- Gradient Overlay (การไล่โทนสี) สามารถเลือกโทนสีได้ 

- Pattern Overlay  (การแสดงพ้ืนผิวแบบต่างๆ) 

- Outer Glow (เรืองแสงภายนอก) 

- Drop Shadow (เงาที่รูปภาพ) 

        

วิธีสร้างกรอบพื้นที่ของตัวอักษรให้มีมิติด้วย เมนู  Layer Style ดังภาพ 

 

 

 

  Blend Mode : Multiply 

  Opacity       :  100  

  Angle          :  120   

  คลิกเลือก Use Global Light 

  Distance      :  85 

  Spread        :  29 

  Size            :  9 
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ตั้งค่ารูปแบบ Layer Style  

คลิกเลือก  Bevel and Emboss  

คลิกเลือก  Stroke 

คลิกเลือก  Outer Glow 

คลิกเลือก  Drop Shadow 

สร้างกรอบพ้ืนที่ของตัวอักษรให้ครบตามจ านวนที่ต้องการ ดังภาพ 

 

จะปรากฏหน้าต่างที่เป็นกรอบภาพส าหรับใส่เนื้อหาบทความครบถ้วนเรียบร้อยแล้ว ดังภาพ 
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               2.1.7 ขั้นตอนการพิมพ์ข้อความใส่ในกรอบรูป 

           เลือกเครื่องมือ (Text Tool) แล้วน ามาคลิกพ้ืนที่ท างาน จะเกิดสัญลักษณ์กระพริบ

เตรียมพร้อมที่จะพิมพ์ตัวอักษร เลือกรูปแบบตัวอักษรไปที่แถบเมนูบาร์ เลือกแบบตัวอักษร และ

ขนาดที่ต้องการ จะเห็น Layers ของตัวหนังสือปรากฏขึ้น  การปรับแต่งรายละเอียดข้อความที่เสร็จ

แล้วสามารถท าได้โดย แดรกเมาส์ปาดให้เกิดแถบด า เพ่ือเลือกตัวอักษรที่ต้องการแก้ไขเลือกแบบ

ฟอนต์ พร้อมกับก าหนดความบาง, หนา, เอียง จากช่องถัดไป กรอกตัวเลขปรับขนาดในช่อง                             

บนเมนู Option ดังภาพ 

 

 

                            เลือกเครือ่งมือ (Text Tool) 

         พิมพ์ข้อความเนื้อหาทั้งหมดให้ครบถ้วน สร้างเทคนิคเพ่ิมเติมให้ตัวอักษรโดยใช้

เครื่องมือ Type Tool การท าหลายๆ ข้อความใช้วิธีการตกแต่ง เพ่ือความสวยงามสามารถท าได้โดย

ใช้วิธีการเดียวกันกับขั้นตอนแรกๆ ทุกอย่างให้ครบถ้วน  ปรับแต่งและจัดวางต าแหน่งตัวอักษรให้

เหมาะสม ดังภาพ 
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                    2.1.8 การสืบค้นหารูปภาพเพื่อน ามาใช้ในการออกแบบ 

          รูปภาพ ( Pictures) แบ่งได้เป็นสองแบบ คือ ภาพบิทแมพทั่วไป Bitmapped 

graphics  เป็นภาพกราฟิกท่ีสร้างข้ึนจากการน าจุดเล็กๆ จ านวนมากมารวมกัน  จะสิ้นเปลืองเนื้อที่ใน

การจัดเก็บมาก  และการขยายภาพให้ใหญ่ขึ้นจะปรากฏรอยหยัก ส่วนภาพเวคเตอร์ Vector เป็น

ภาพที่วาดขึ้นด้วยคอมพิวเตอร์นั่นเอง  รูปภาพเป็นส่วนประกอบที่ส าคัญอันที่สองในการออกแบบ 

เพ่ือดึงดูดความสนใจแสดงประกอบเรื่องราว ให้เกิดความรู้สึก  ความเข้าใจคล้อยตามวัตถุประสงค์  

         การเลือกภาพที่จะน ามาใช้ในงานออกแบบ ปัจจุบันสามารถค้นคว้าได้ในอินเตอร์เน็ต

จากเว็บไซด์ www.google.com  มีภาพสวยๆ ให้เลือกมากมาย  หรือจากภาพถ่ายที่เราเก็บไว้ในคลัง

รูปภาพ สามารถน ามาใช้ได้ถ้าเห็นว่าเหมาะสม  วิธีการหาภาพใน www.google.com  คีย์ข้อมูลหรือ

ข้อความลงในช่องส าหรับพิมพ์แล้วกด Enter ดังภาพ 

 

http://www.google.com/
http://www.google.com/


64 

 

  

 

 

 
 

 

 

 

 

                                                   คีย์ข้อมูลภาพที่ต้องการ 
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    ดับเบ้ิลคลิกเข้าไปเพ่ือ 

       หาภาพที่ต้องการ 
 

 

 

 

 

 

                 เมื่อได้รูปที่ต้องการแล้วคลิกขวาและใช้ค าสั่ง  Save picture ดังภาพ 

                                                                        Save picture as 
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           เมื่อได้ภาพที่ต้องการเจอภาพท่ีต้องการแล้วเก็บภาพโดยใช้ค าสั่ง Save picture น าไปไว้ที่

โฟลเดอร์ Libraries > Picture  ไว้ส าหรับเก็บเป็นคลังภาพของเราใช้ในการท างาน  จะเพ่ิมความ

สะดวกรวดเร็วในการออกแบบเรื่องอ่ืนๆ ต่อไป 

                   Save picture                                            น าไปไว้ที่โฟลเดอร์ Libraries > Picture   

 

 

 

 

 

 

 

 

 

 

 

 

                                                                                                 คลิก  Save 

        ค้นหารูปต่อไป เมื่อได้ภาพที่ต้องการแล้ว เก็บภาพโดยใช้ค าสั่ง Save picture as ทุกรูปภาพใช้

วิธีเดียวกันทุกขั้นตอน ดังภาพ                                                                     
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การค้นหาภาพเพ่ือน ามาสร้างชิ้นงาน  เราต้องเปิดไฟล์ภาพจากแหล่งข้อมูลต่างๆ เช่น จาก

แผ่นซีดีภาพถ่าย จากกล้องดิจิตอล หรือไฟล์ภาพในเครื่องคอมพิวเตอร์ ซึ่งมีข้ันตอนดังต่อไปนี้  

1. คลิกเลือกเมนู File > Open หรือกด Ctrl+O ที่คีย์บอร์ดเพ่ือเปิดไฟล์  

2. จะปรากฏหน้าต่าง Open เลือกต าแหน่งที่ เก็บไฟล์ภาพในช่อง Look in แล้วเลือกไฟล์

ภาพที่ต้องการ        

          3. คลิกปุ่ม Open เพ่ือเปิดไฟล์ภาพขึ้นมาในหน้าจอโปรแกรม (ถ้าต้องการเปิดหลาย ภาพให้

กด Ctrl ค้างไว้ขณะเลือกไฟล์ที่ต้องการ  

 

วิธีเรียกรูปภาพที่เก็บไว้ในคลังภาพน าออกมาใช้ 

เปิดที่เมนู  file  ท าตามขั้นตอน ให้เปิด File open เลือก Libraries>Picture หาภาพที่

ต้องการแล้วใช้ค าสั่งโดยการคลิกที่ภาพนั้นๆ  แล้วกดปุ่ม Open เพ่ือน าไปเป็นรูปภาพประกอบของ

งานที่เราออกแบบ 

 

คลิกเลือกเมนู File > Open 
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                   2.1.9  การปรับแต่งรูปภาพเพื่อน ามาใช้ในการออกแบบ 

          เมื่อเปิดภาพเสร็จเรียบร้อยแล้ว วิธีตัดภาพเพ่ือไปใช้ในงานออกแบบบอร์ดความรู้ 

โดยการใช้เครื่องมือ Elliptical Marquee Tool  สร้างเส้น Selection เป็นรูปวงรี เพ่ือตัดภาพหรือ 

copy ภาพ 

 

 

 

               

เครื่องมือกลุ่ม Marquee 

 

 

                                                                          

                                                               Elliptical Marquee Tool 

 
 

 



69 

 

  

คุณสมบัติของเครื่องมือกลุ่ม Marquee 

Rectangular Marquee Tool ใช้สร้างเส้น Selection เป็นรูปสี่เหลี่ยม (ถ้ากดคีย์ Shift 

ค้างไว้ เส้น Selection จะเป็นรูปสี่เหลี่ยมจัตุรัส) 

Elliptical Marquee Tool ใช้สร้างเส้น Selection เป็นรูปวงรี (ถ้ากดคีย์ Shift ค้างไว้เส้น 

selection จะเป็นวงกลม 

Single Row Marquee Tool ใช้สร้างเส้น Selection เป็นเส้นตรงลักษณะแนวนอน 

Single column Marquee Tool ใช้สร้างเส้น Selection เป็นเส้นตรงลักษณะแนวตั้ง 
 

เปิดมาที ่File เดิม แล้วเลือกแถบค าสั่ง Edit > Paste หรือท าได้อีกวิธี คือการเปิด Select > 

All ที่รูปภาพ แล้วเลือกแถบค าสั่ง Edit >Copy อีกวิธีหนึ่งเปิดไฟล์ภาพที่ต้องการ ท าการ Elliptical 

Marquee Tool ใช้สร้างเส้น Selection มาครอบภาพทั้งหมดในรูปจะเกิดเส้นปะทั้งรูปไปที่  Move 

Tool  เลือกเครื่องมือ (ลูกศร)  แล้วคลิกค้างทีภ่าพจากนั้นให้ลากมาทีห่น้างานได้เลย 

 

 

 
 



70 

 

  

Copy ภาพที่ 2 เปิดที่เมนู  file  ท าตามขั้นตอน ให้เปิด File open เลือกLibraries>Picture 

หาภาพที่ต้องการแล้วใช้ค าสั่งโดยการคลิกท่ีภาพนั้นๆ  แล้วกดปุ่ม Open 

 

 

 

 
 

 

 

 

                         เลือกแถบค าสั่ง Edit >Copy                          Elliptical Marquee Tool 

 

 

 

 

 

 

    เลือกแถบค าสั่ง Edit > Paste 

 



71 

 

  

ปรับขนาดของภาพที่ต้องการให้เหมาะสมโดยเลือกแถบค าสั่ง Edit > Free Transform เพ่ือ

ดึงภาพให้ย่อหรือขยาย หรือหมุนได้ตามต้องการ เมือ่ย่อ-ขยายได้ตามต้องการแล้วให้กด Apply วาง

ต าแหน่งให้สวยงามตามภาพแสดงตัวอย่างด้านล่าง 

                 

                เลือกแถบค าสั่ง Edit > Free Transform 

 

            

วางต าแหน่งของภาพให้เหมาะสมสวยงาม           คลิก  Apply   
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จัดเรียงภาพให้สวยงาม  วางต าแหน่งให้เหมาะสม และตรวจทานรายละเอียดของเนื้อหาให้

ถูกต้องครบถ้วน  จากนั้นรวมเลเยอร์ให้เป็นหนึ่งเดียว  และท าการบันทึกข้อมูลไว้ให้เรียบร้อย 
 

 

 

                                                             คลิกขวาแล้วเลือก   Flatten Image 
 

             วิธีรวมเลเยอร์ทั้งหมดผ่านแถบเครื่องมือ  คลิกเลเยอร์ (layer ) ภาพไหนก็ได้ คลิก

ขวา แล้วเลือก Flatten Image จากนั้นท าการบันทึกข้อมูล 

               2.1.10  การบันทึกข้อมูลและรูปภาพ 

           การบันทึก ( Save) ข้อมูลสามารถท าได้โดยเลือก File > Save จะเกิด Box ขึ้นมา 

การเลือก Save As จะใช้ในกรณีไม่เคยมีการ save มาก่อนเป็นการบันทึกครั้งแรก และที่ต้องการ 

Save File เพ่ิมในงานเดิมแตต่้องเปลี่ยนชื่อใหม ่

1) เลือกพ้ืนทีเ่ก็บข้อมูล 

2) พิมพ์ชื่องาน 

3) เลือก Format ของงาน  การเลือกรูปแบบการบันทึก (Format) สามารถเลือกได้

ตามลักษณะการใช้งาน เลือกนามสกุล Photoshop (*PSD.*.PDD) สามารถน ามาแก้ไขได้  แต่จะ

เปลืองพ้ืนที่หน่วยความจ ามากเลือก JPEG (*.JPG;*.JPEG;*.JPE) ไม่สามารถแก้ไขได้   แต่ใช้
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หน่วยความจ าน้อย  และจะท าการรวม Layer โดยอัตโนมัติ  งานที่ท าส าเร็จสมบูรณ์  พร้อมที่จะ

น าไปพิมพ์ได ้ ท าการพิสูจน์อักษรก่อนส่งโรงพิมพ์ทุกครั้งเลือก File > Save As ดังภาพ 

 

 

 

 

 

 เลือกพ้ืนที่เก็บ   

ข้อมูล 

 

                 

      พิมพ์ชื่องาน 

         

           เลือกสกุล JPEG    

(*.JPG;*.JPEG;*.JPE) 
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การเลือกรูปแบบการบันทึก (Format) สามารถเลือกได้ตามลักษณะการใช้งานเลือก 

นามสกุล Photoshop (*PSD.*.PDD)  สามารถน ามาแก้ไขได้ แต่จะเปลืองพ้ืนที่หน่วยความจ าเลือก 

JPEG (*.JPG;*.JPG;*.JPE) ไม่สามารถแก้ไขได้แต่หน่วยความจ าน้อย และจะท าการรวม Layer โดย

อัตโนมัติ  

  

 

 

           

                จบขั้นตอนการจัดท าบอร์ดความรู้ด้วยโปรแกรม  Adobe Photoshop CS6 และได้งาน

ที่เสร็จสมบูรณ์  พร้อมที่จะน าไปพิมพ์ได้                                                   
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ภาพที่ 10  ภาพตัวอย่างการออกแบบท่ีเสร็จเรียบร้อยแล้วเพื่อน าเสนอต่อไป 

                    2.1.11  การสั่งพิมพ์งาน (Print) 

           เมื่อด าเนินการออกแบบและตรวจสอบความถูกต้องแล้ว  ต้องสั่งพิมพ์งานเพ่ือจะได้

น าไปเผยแพร่ความรู้ต่อไป  การสั่งพิมพ์งานโดยใช้บริการร้านปริ้นไวนิลโดยเฉพาะ  ซึ่งจะมีความ

คมชัดสวยงาม  เมื่อผ่านการตรวจสอบ  และแก้ไขงานเรียบร้อยแล้ว  ผู้ปฏิบัติงานจะต้องส่งไฟล์งาน

พิมพ์ไปยังร้านที่รับปริ้นงานไวนิล  ในที่นี้ใช้บริการ บริษัท Pro Print จ ากัด เนื่องด้วยเครื่องปริ้นไวนิล

มีราคาสูงมาก ถ้าซื้อเครื่องน ามาใช้งานในหน่วยงานที่มีการPrint จ านวนน้อยจะไม่คุ้มกับค่าใช้จ่าย 

ดังนั้นจึงจ าเป็นใช้บริการร้านที่รับปริ้นงานไวนิลเพ่ือให้ได้งานที่ต้องการ ทุกขั้นตอนของการท างาน
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ต้องรีบด าเนินการด้วยความรวดเร็ว  แต่ก็ต้องมีความถูกต้องและสวยงามด้วยจึงจะถือว่าเป็นงานที่ดีมี

คุณภาพ 

เทคนิคการออกแบบป้ายบอร์ดความรู้ด้วยคอมพิวเตอร์ 

การออกแบบงานกราฟิกโดยการใช้โปรแกรมคอมพิวเตอร์   Adobe Photoshop CS6 นั้น

ไม่ได้จ ากัดอยู่เพียงแค่การออกแบบป้ายไวนิลอย่างเดียว  แต่สามารถใช้ในการออกแบบงานสื่อต่างๆ 

ได้หลายอย่าง  เช่น ปกเอกสาร โปสเตอร์ แผ่นปลิว แผ่นพับ  บอร์ดความรู้ การ์ด เป็นต้น ได้ศึกษา

เรียนรู้แล้วจะท าให้ได้ความรู้   ได้แนวคิดเทคนิควิธีการที่จะต่อยอดไปสู่งานสร้างสรรค์อ่ืนๆ อีก

มากมาย  แม้แต่การออกแบบนิทรรศการก็สามารถประยุกต์ใช้ได้เช่นกัน  นอกจากนั้นโปรแกรม 

Adobe Photoshop CS6 ยังมีเทคนิคพิเศษอีกมากมายให้ได้เรียนรู้จากแนวทางที่ ได้น าเสนอไปแล้ว  

สิ่งที่ต้องการแนะน าให้กับผู้ปฏิบัตินั้น ก็คือนอกจากจะต้องอ่านเนื้อหาเพ่ิมเติมแล้วสิ่งที่ส าคัญที่สุดก็

คือ  ต้องฝึกปฏิบัติอย่างต่อเนื่องและบ่อยๆ เพราะถ้าศึกษาเรียนรู้แล้วไม่ได้ฝึกปฏิบัติก็จะท าให้ลืมได้

อย่างง่ายดาย  แต่ถ้าได้มีโอกาสฝึกปฏิบัติ  นอกจากจะได้ทบทวนความรู้แล้วยังมีโอกาสได้ทดลองใช้

เทคนิคต่างๆ ที่มีอยู่ใน Filter ซ่ึงจะมีรูปแบบพิเศษที่หลากหลายสวยงาม ไปปรับใช้ให้เหมาะสมกับ

งานทีเ่ราต้องการได้อีกด้วย และส่งเสริมให้งานในหน้าที่รับผิดชอบมีประสิทธิภาพมากยิ่งขึ้นต่อไป 
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ภาพที่ 11  ภาพตัวอย่างผลงานส าเร็จ 
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ภาพที่ 12  ภาพตัวอย่างผลงานส าเร็จ 
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ภาพที่ 13  ภาพตัวอย่างผลงานส าเร็จ 
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ภาพที่ 14  ภาพตัวอย่างผลงานส าเร็จ 

 

 

 

 

 

 

 

 

 

 

 

 



บทที่ 5 

วิเคราะห์ปัญหา อุปสรรคและแนวทางการแก้ไขปัญหา 

 

การน าเสนอข้อมูลความรู้เป็นสิ่งส าคัญที่จะถ่ายทอดอย่างไรให้คนทั่วไปได้เห็นคล้อยตาม 

บางครั้งอุปสรรคและปัญหาการด าเนินงานในการปฏิบัติงานการท าบอร์ดเผยแพร่ความรู้อาจเกิดข้ึนได้  

ผู้จัดท าคู่มือปฏิบัติงาน  ขอสรุปแล้วท าการแยกออกเป็นประเด็นๆ  คู่มือฉบับนี้ได้ด าเนินการให้บรรลุ

ตามวัตถุประสงค์ เพ่ือให้ผู้ปฏิบัติงานด้านการจัดท าบอร์ดความรู้  ได้ใช้เป็นแนวปฏิบัติให้งานส าเร็จ

ตามวัตถุประสงค์อย่างมีคุณภาพ ได้แก่ 

1. กระบวนการท างานของการจัดท าบอร์ดความรู้ 

2. การด าเนินการค้นคว้าหาข้อมูล 

3. ขั้นตอนการด าเนินการออกแบบบอร์ดความรู้ด้วยโปรแกรม Adobe Photoshop CS6 

ทุกข้ันตอนมีปัญหาอุปสรรคที่พบ  และแนวทางการแก้ไขปัญหาที่คาดว่าจะช่วยท าให้ปัญหา

ลดน้อยลงหรือหมดไป  ซึ่งสามารถน าเสนอได้ดังต่อไปนี้  มีดังนี ้

 

ขั้นตอนที่ 1   วิเคราะห์ปัญหา อุปสรรคจากกระบวนการท างานของการจัดท าบอร์ดความรู้ 

       ปัญหาและอุปสรรค   

1.1 กระบวนการผลิตชิ้นงานต้องผ่านการตรวจสอบและคัดเลือกเนื้อหาใช้เวลานานท า 

ให้เรื่องท่ีน าเสนอไม่ทันสมัย  

1.2 การเบิกเงินค่าจัดซื้อจัดจ้างมีความล่าช้า 

                  1.3 การตรวจสอบอักษร การใช้ค าราชาศัพท์  ค าเชื่อมประโยคต่างๆ การใช้ค า 

เครื่องหมายวรรคตอน และค าสะกดต่างๆ ยังไม่ถูกต้องที่สุด 

                  1.4 ร้านที่รับปริ้นงานป้ายไวนิล ส่งงานส าเร็จไม่ทันตามเวลาที่ก าหนด 

                 ข้อเสนอแนะและแนวทางแก้ไข  

                  ผู้จัดท าคู่มือ ได้มีการวางแผนก าหนดระยะเวลาในการน าเสนอ ให้ได้ด าเนินการตาม

ระยะเวลาที่ก าหนดไว้ และได้มีการวางแผนก าหนดระยะเวลาในการเบิกเงินค่าจัดซื้อจัดจ้าง ให้ทันต่อ

การด าเนินการตามระยะเวลา ได้ค้นคว้าค าเหล่านั้นจากคู่มือหนังสือราชบัณฑิตยสถานฉบับปัจจุบัน
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ส าหรับป้ายไวนิลที่ทางร้านท าเสร็จเรียบร้อยแล้ว ผู้จัดท าคู่มือไปรับด้วยตนเอง และเปลี่ยนร้านที่เขา

สามารถมาส่งงานส าเร็จได้ทันตามก าหนดเวลา 

 

ขั้นตอนที่ 2   วิเคราะห์ปัญหา อุปสรรคในการด าเนินการค้นคว้าหาข้อมูล 

                 ปัญหาและอุปสรรค  

        2.1 การค้นคว้าหาข้อมูลต้องสืบค้นหาข้อเท็จจริงว่าข้อมูลถูกต้องเป็นเรื่องจริงหรือไม่ 

ก่อนน าเสนอ 

                  2.2 ขั้นตอนในการหาข้อมูลจากอินเทอร์เน็ต มีความซับซ้อนและมีแหล่งข้อมูลมาก 

                  2.3 ข้อมูลไม่มีความแปลกใหม่ ไม่เป็นที่น่าสนใจ  

                 ข้อเสนอแนะและแนวทางแก้ไข 

                  ผู้จัดท าคู่มือ ได้น าบทความของฝ่ายบริการเผยแพร่ทางไกลที่ผ่านคณะกรรมการ

ตรวจสอบความถูกต้องแล้วนั้นมาน าเสนอ ใช้วิธี เปิดหาข้อมูลหลายเว็บไซด์ (website) เพ่ือ

เปรียบเทียบค้นคว้า  ศึกษาหาข้อมูลเพ่ิมเติมจากเอกสารในห้องสมุด หรือแหล่งข้อมูลอ่ืนๆ ดูจาก

ข้อเสนอแนะจากผู้สนใจอ่านบอร์ดที่ผู้จัดท าคู่มือ ได้ท าแบบสอบถามใบประเมินบอร์ดแล้วนั้น ค้นคว้า

ศึกษาหาข้อมูลเพ่ิมเติมจากเอกสารในห้องสมุดของมหาวิทยาลัย หรือตามแหล่งต่างๆ เช่น ร้าน

หนังสือ  Internet  เพ่ือจะได้มีแนวความคิดใหม่ๆ ในการท างาน 

 

ขัน้ตอนที่ 3   วิเคราะห์ปัญหา อุปสรรคในการด าเนินการออกแบบบอร์ดความรู้ด้วยโปรแกรม 

Adobe Photoshop CS6 

                 ปัญหาและอุปสรรค  

                  3.1 ปัญหาจากกระบวนการท างาน เกิดจากจากโปรแกรมลิขสิทธิ์ มีความยุ่งยากใน

การด าเนินการจัดซื้อจัดจ้าง และต้องอยู่ในความดูแลและด าเนินการของส านักคอมพิวเตอร์  

                  3.2 ปัญหาระบบไฟฟ้าของหน่วยงานดับบ่อย ท าให้เกิดความล่าช้าในการท างาน                 

                  3 .3 ปัญหาจากการใช้ งาน โปรแกรม Adobe Photoshop CS6  ผู้ปฏิ บั ติ ไม่ มี

ประสบการณใ์นโปรแกรมเท่าที่ควร 

                  3.4 ปัญหาการใช้งานบนคอมพิวเตอร์ PC หน่วยความจ าของเครื่องคอมพิวเตอร์น้อย               
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                 3.5 เครื่องพิมพ์งานส าเร็จระบบ Laser หมึกพิมพ์ที่ใช้มีค่าใช้จ่ายที่ค่อนข้างแพง ท าให้

กระทบกับงบประมาณรายจ่ายประจ าปี 

                 3.6 ไม่มีเครื่องพิมพ์งานเฉพาะไวนิล 

                 3.7 โปรแกรม Adobe Photoshop มีการเปลี่ยนแปลง Version ตลอดเวลา   

                 ข้อเสนอแนะและแนวทางแก้ไข   

                 ประสานงานกับส านักงานเลขานุการส านักการศึกษาต่อเนื่อง  เพ่ือเร่งรัดการด าเนินงาน 

ตรวจเช็คจ านวนครั้งที่ไฟฟ้าดับในแต่ละเดือนเพ่ือเป็นข้อมูลแจ้งให้หน่วยงานที่รับผิดชอบแก้ไขปัญหา

ทั้งระยะสั้นและระยะยาว ดูรายละเอียดการใช้งานในอินเทอร์เน็ต และฝึกฝนการใช้โปรแกรม Adobe 

Photoshop CS6 เพ่ิมหน่วยความจ า (Memory Unit) ให้กับคอมพิวเตอร์ และจัดซื้อเครื่องพิมพ์

ระบบ Inkjet มาทดแทนแม้ว่าคุณภาพจะสู้ระบบ Laser ไม่ได้ ส่วนป้ายไวนิลท าเรื่องจัดจ้างปริ้น 

เนื่องจากเครื่องพิมพ์ไวนิลมีราคาค่อนข้างสูง  ถ้าปริ้นงานเฉพาะไวนิลนานๆ ครั้งจะไม่คุ้มค่า  

แก้ปัญหาโดยการจัดจ้างพิมพ์ ผู้เขียนคู่มือต้องใช้ความพยายาม หาความรู้ความสามารถเพ่ือศึกษา

ข้อมูลเพิ่มเติมอยู่ตลอดเวลาเมื่อมีการเปลี่ยนแปลง Version โปรแกรม Adobe Photoshop ใหม่ๆ 

     สภาพปัญหา และอุปสรรคงานด้านการจัดท าบอร์ดความรู้ อาจเกิดข้ึนได้ตลอดเวลา บาง

ปัญหามีแนวทางแก้ไขตามที่วิเคราะห์ไว้  หรืออาจจะพบปัญหาใหม่เกิดขึ้น ดังนั้นผู้จัดท าคู่มือจึงได้

ศึกษาหาแนวทางในการแก้ไขปัญหาดังกล่าวไว้ล่วงหน้าเพ่ือให้การปฏิบัติงานด้านการออกแบบบอร์ด

ความรู้มีประสิทธิภาพและคุณภาพดียิ่งขึ้น และเป็นที่ยอมรับจากสังคมภายนอกการท างานออกแบบ

ในปัจจุบันจะแตกต่างจากเดิมมากเพราะมีเทคโนโลยีใหมต่่างๆ  มาช่วยให้การท างานเป็นไปด้วยความ

รวดเร็ว แต่ถึงแม้จะมีเทคโนโลยีมาเป็นเครื่องมือช่วยมากมายแล้ว  ก็ยังมีปัญหาอุปสรรคทั้งปัญหา

จากวัสดุอุปกรณ์และปัญหาด้านอื่นๆ พอจะสรุปได้ดังนี้ 

 

1. ปัญหาและอุปสรรคที่เกิดจากอุปกรณ์เครื่องมือ ซึ่งแยกเป็น 

 1.1  ด้านเครื่องมือ (Hardware) ปัญหาที่เกิดจากเครื่องมือมีไม่เพียงพอและตกรุ่นเร็ว  

เพราะเทคโนโลยีมีการพัฒนาอย่างรวดเร็ว ท าให้ปรับเปลี่ยนตัวอุปกรณ์ต่างๆ ไม่ทันเนื่องจากมีปัจจัย

ในเรื่องค่าใช้จ่าย รวมทั้งกระบวนการจัดซื้อจัดจ้างที่ใช้เวลานาน กว่าจะได้เครื่องมือมาก็ช้าเกินไป 
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           1.2  เครื่องปริ้นเตอร์สีมีจ านวนจ ากัด ไม่เพียงพอต่อการใช้งาน และเนื่องจากมีแค่เครื่อง

เดียวท าให้ใช้งานค่อนข้างหนักจนบางครั้งก็จะเกิดปัญหาขึ้นมา  นอกจากนี้ผงหมึกยังมีราคาค่อนข้าง

สูง ท าให้กระทบกับค่าใช้จ่ายของส านัก 

           1.3  ด้านวัสดุ (Software) โปรแกรมการท างานเป็นโปรแกรมลิขสิทธิ์  กระบวนการจัดซื้อ

โปรแกรมจะต้องผ่านส านักคอมพิวเตอร์ ท าให้เกิดการล่าช้าเมื่อมีโปโปรแกรม Adobe Photoshop 

เปลี่ยนแปลง Version ใหม่ๆ เข้ามา  ซึ่งส านักคอมพิวเตอร์ไม่สามารถจัดซื้อให้ได้ทันท่วงที 

  1.4  โปรแกรม (Software) มีการเปลี่ยนเวอร์ชั่นเร็ว ท าให้ต้องท าการ Upgrade โปรแกรม

ให้ทันสมัย นอกจากนี้ยังมีปัญหาในด้านไวรัสที่เข้ามารบกวนการท างาน  ท าให้เกิดความล่าช้า   

  

แนวทางแก้ไขและข้อเสนอแนะ 

   เนื่องจากมีปัจจัยในเรื่องค่าใช้จ่ายเข้ามาเกี่ยวข้องในด้านของอุปกรณ์  การจะปรับเปลี่ยน

เครื่องมือต่างๆ จะต้องมีการวิเคราะห์ข้อดีข้อด้อย  ความคุ้มค่าความเหมาะสมพอสมควร  ดังนั้นการ

แก้ไขปรับปรุงเครื่องมืออาจจะเป็นเรื่องยากกว่าการศึกษาหาข้อมูลถึงโปรแกรมที่มีความสามารถใช้

งานได้ดี มีปัญหาน้อยมาแก้ไขปัญหาก่อน  ส่วนการแก้ปัญหาเครื่องปริ้นเตอร์นั้น เครื่อง Laser 

Printer แม้จะมีราคาแพงทั้งตัวเครื่องและผงหมึก แต่ก็ยังมีความจ าเป็นที่จะต้องใช้งานอยู่ เพราะงาน

หลายๆ งานนั้นยังต้องการความประณีตสวยงาม  แต่ควรก าหนดขอบเขตการปริ้นงานให้เหมาะสม 

และควรมีเครื่อง Printer สีแบบธรรมดา ที่มีราคาเครื่องและผงหมึกไม่แพงมาใช้งานทั่วไปแทน 

กรณีโปรแกรมไม่ถูกต้องลิขสิทธิ์ ควรด าเนินการให้ส านักงานเลขานุการส านักการศึกษา

ต่อเนื่อง  แจ้งให้ส านักคอมพิวเตอร์ด าเนินการจัดหา/จัดซื้อโดยเร็วอีกครั้ง  โดยจะต้องอธิบาย

ความส าคัญของการใช้โปรแกรมให้ส านักคอมพิวเตอร์เข้าใจและรีบด าเนินการ  หากไม่สามารถ

ด าเนินการได้  ควรเสนอให้ด าเนินการจัดซื้อโดยใช้งบประมาณการด าเนินงานของส านักฯ หรือ

น าเสนอข้อมูลต่อคณะกรรมการบริหารส านักฯ เพ่ือขออนุมัติเงินของส านักฯ จัดซื้อ 

  

2.  ปัญหาจากบุคลากร 

  2.1  ด้านจ านวนบุคลากร การท างานด้านออกแบบนั้นจ าเป็นต้องเป็นบุคคลที่มีความรู้

ความสามารถทางด้านศิลปะ  ออกแบบ  จิตรกรรม  ซึ่งสามารถที่จะจินตนาการหรือสร้างสรรค์งาน

ออกมาได้ตามหลักวิชา หรือตามทฤษฎีทางศิลปะ  นอกจากนี้ยังต้องมีความสามารถในการท างาน
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ออกแบบด้วยโปรแกรมคอมพิวเตอร์ซึ่งมีหลายโปรแกรม เช่น โปรแกรม Adobe Photoshop, 

Adobe Illustrator, Adobe PageMaker, Adobe Indesign  ดังนั้นปัญหาจ านวนของบุคลากรที่มี

คุณสมบัติครบถ้วนทั้งความรู้ทางศิลปะและความสามารถในโปรแกรม  Graphic  จึงมีจ านวนน้อย 

 2.2  ด้านความสามารถของบุคลากร  ในปัจจุบันโปรแกรมการท างานด้าน Graphic ได้

พัฒนาไปอย่างรวดเร็ว  มีการออกเวอร์ชั่นใหม่ๆ มาเสมอ  บุคลากรที่ท างานด้าน Graphic Design 

จึงต้องพยายามศึกษาหาความรู้เพ่ิมเติมอย่างต่อเนื่อง  ทั้งจากเอกสารหรือหนังสือคู่มือต่างๆ รวมทั้ง

การค้นคว้าข้อมูลทาง Internet  แต่ก็ยังไม่สามารถท างานได้ครอบคลุมทุกความสามารถของ

โปรแกรม  โดยเฉพาะอย่างยิ่งในปัจจุบันได้มีการพัฒนาการออกแบบ  แบบแปลกใหม่มากยิ่งขึ้น  มี

การพัฒนาโปรแกรมทางด้าน Graphic Design ขึ้นมามากมาย แม้บุคลากรจะมุ่งพัฒนาเรียนรู้เพ่ือให้

ทันเทคโนโลยี  แต่ก็ไม่สามารถท่ีจะเรียนรู้ได้ทันเพราะความรู้พื้นฐานไม่ได้จบมาทางด้านคอมพิวเตอร์  

 

แนวทางแก้ไขและข้อเสนอแนะ  

 การพัฒนาบุคลากร  บุคลากรที่ท างานด้าน Graphic Design จะต้องพัฒนาความรู้

ความสามารถอยู่เสมอเพ่ือความทันสมัยของเทคนิควิธีการต่างๆ  และต้องมีการแนะน าหรือแนะ

แนวทางให้กันอยู่เสมอ โดยเฉพาะอย่างยิ่งเมื่อมีการไปอบรมหรือสัมมนาเทคนิควิธีการใหม่ๆ จะต้อง

น ามาถ่ายทอดให้บุคลากรคนอ่ืนได้รับรู้ เพราะนอกจากจะเป็นการเผยแพร่ความรู้ให้บุคลากรคนอ่ืนได้

รับรู้แล้วยังเป็นการทบทวนความรู้ความเข้าใจของบุคคลผู้นั้นอีกด้วย   
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 บอร์ดความรู้น าออกเผยแพร่   

 ทางอินเทอร์เน็ต 

 

 

 

 

 

 

 

  

ภาพที่ 15  ตัวอย่างบอร์ดความรู้ที่เผยแพร่ทางอินเทอร์เน็ต ทางช่องทางประชาสัมพันธ์โครงการ

สัมฤทธิบัตร ของฝ่ายบริการเผยแพร่ทางไกล ส านักการศึกษาต่อเนื่อง 
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ภาพที่ 16  ตัวอย่างตอบแบบประเมินบอร์ดความรู้ที่เผยแพร่ทางอินเทอร์เน็ต พร้อมรับของที่ระลึก 

(ดับเบิ้ลคลิกที่ ตอบแบบประเมิน) 
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ภาพที่ 17  ตัวอย่างแบบฟอร์มการตอบประเมินบอร์ดความรู้ที่เผยแพร่ทางอินเทอร์เน็ต 
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ภาพที่ 18  ตัวอย่างยอดผู้เข้าชมบอร์ดความรู้ที่เผยแพร่ทางอินเทอร์เน็ต 
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                 ภาพที่ 19  ตัวอย่างแบบฟอร์มการตอบประเมินบอร์ดความรู้ที่เผยแพร่ใน      

มหาวิทยาลัยสุโขทัยธรรมาธิราช 
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                  ภาพที่ 20  ตัวอย่างจดหมายแนบพร้อมของที่ระลึกส าหรับผู้ที่ตอบประเมินบอร์ด

ความรู้ที่เผยแพร่ทางอินเทอร์เน็ต 
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